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This computer program (including software design, programming structure, 
graphics, manual, and on-line help) was created by StructurePoint, formerly the 
Engineering Software Group of the Portland Cement Association.  
 
 
 
While StructurePoint has taken every precaution to utilize the existing state-of-the-art and to assure the 
correctness of the analytical solution techniques used in this program, the responsibilities for modeling 
the structure, inputting data, applying engineering judgment to evaluate the output, and implementing 
engineering drawings remain with the structural engineer of record. Accordingly, StructurePoint does 
and must disclaim any and all responsibility for defects or failures of structures in connection with 
which this program is used. 

 
 
Copyright © 2002 – 2008, STRUCTUREPOINT, LLC. All Rights Reserved. All trademarks, service 
marks, and trade names referenced in this material are the property of their respective owners. 
pcaColumn is a registered trademark of the Portland Cement Association and is used by StructurePoint 
under license. 
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STRUCTUREPOINT  
EVALUATION SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR 
OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE 
WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION 
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS 
APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
STRUCTUREPOINT.  
STRUCTUREPOINT, LLC. 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER SP), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE 
TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER 
DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY SP DIRECTLY OR THROUGH 
AN AUTHORIZED DEALER OF SP (HEREAFTER DEALER). 
WHILE SP HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
SP AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT SP IS UNDER NO OBLIGATION TO 
PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FIT NESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL SP OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL 
OR OTHER DAMAGES, EVEN IF SP OR DEALER (IF ANY) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD 
PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE 
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OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON 
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR 
USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, 
INAC CURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO 
THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; 
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILI TIES; (5) SP NOT 
PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE 
SOFTWARE OR USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS 
NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION 
CAUSED BY (a) ACCIDENT, (b) NEGLI GENCE OR ABUSE BY CUSTOMER, (c) ACTS OF 
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, 
MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING 
USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND 
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO 
EVENT SHALL SP BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR 
ANY OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. 
THIS SOFTWARE AND USER DOCUMENTATION IS LICENSED TO YOU BY 
STRUCTUREPOINT, LLC AN ILLINOIS LIMITED LIABILITY COMPANY. IN NO EVENT 
SHALL PORTLAND CEMENT ASSOCIATION (PCA) BE LIABLE FOR: (A) LOSS OF PROFITS, 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL 
OR OTHER DAMAGES, EVEN IF PCA, STRUCTUREPOINT OR ANY OTHER PERSON HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST 
YOU BY ANY THIRD PARTY; OR (C) ANY DAMAGES WHATSOEVER, INCLUDING 
DAMAGES CAUSED BY OR ATTRIBUTABLE TO (1) DELAY IN DELIVERY OF THE 
SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE 
PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF 
THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, 
MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO 
PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER 
DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S 
RESPONSIBILITIES; (5) STRUCTUREPOINT FAILING TO PROVIDE UPDATES, BUG FIXES 
OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) 
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE 
OR USER DOCUMENTATION CAUSED BY OR ATTRIBUTABLE TO (a) ACCIDENT, (b) 
NEGLIGENCE OR ABUSE BY YOU OR ANY OTHER PERSON, (c) ACTS OF THIRD PERSONS 
INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER 
CORREC-TIVE WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTER-
NAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) 
FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL 
PCA BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER 
UNDERSTANDINGS BETWEEN YOU AND STRUCTUREPOINT OR ANY OTHER PERSON 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. YOU AGREE THAT 
STRUCTUREPOINT IS SOLELY RESPONSIBLE FOR YOUR USE OF OR INABILITY TO USE 
THE SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND SP AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
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AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY SP'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMEN 
TATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE 
RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.    
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by SP, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; 
(3) reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by SP. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in SP. Customer may use the Software at only 
one designated workstation at Customer's site at any given time. Customer may not transmit the 
Software electronically to any other workstation, computer, node or terminal device whether via a 
local area network, a wide area network, telecommunications transmission, the Internet or other 
means now known or hereafter created without prior written permission by SP.  

(b) Customer acknowledges that this is a limited license for trial and evaluation purposes only. This 
limited license shall automatically terminate upon fifteen days after the installation of the 
Software. Thereafter, Customer may only use the Software and Documentation if it acquires a 
production license for the same.  

 
 
 
2. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or 
installs, copies or otherwise uses the Software or User Documentation until: (1) it is terminated by 
Customer, by Dealer (if any) on behalf of Customer or SP or by SP as set forth herein; or (2) the 
limited trial and evaluation license terminates.  

(b) This Agreement may be terminated by SP without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to SP.  

 
3. BACKUP AND REPLACEMENT COPIES  

 
Customer may make one copy of the Software media for back-up and archival purposes only, 
provided SP's copyright and other proprietary rights notices are included on such copy. Customer 
shall request additional copies from SP if required. 

 
4. PROTECTION AND SECURITY  
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(a) Customer shall not provide or otherwise make available any of the Software or User 
Documentation in any form to any person other than employees of Customer with the need to 
know, without SP's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of SP. Upon termination of 
this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon SP’s request, Customer shall certify its compliance in writing 
with the foregoing to SP. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If SP prevails in an action against Customer for breach of the provisions of this Section 4, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by SP in 
connection with such action in addition to any award of damages. 

 
5. CUSTOMER'S RESPONSIBILITIES  

 
The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; 
(c) all results obtained from use of the Software and User Documentation; and (d) the selection, 
use of, and results obtained from any other software, programming equipment or services used 
with the Software or User Documentation. 

 
6. LIMITED WARRANTIES  

 
SP and Dealer (if any) warrants to Customer that: (a) SP and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted 
hereunder; (b) the Software and User Documentation provided hereunder is SP's most current 
production version thereof; and (c) the copy of the Software provided hereunder is an accurate 
reproduction of the original from which it was made.  

 
7. LIMITATION OF REMEDY  

(a) SP AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. 
CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR 
NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, SP, 
DEALER (IF ANY), OR ANY OTHER CAUSE WHATSO EVER, AND REGARDLESS 
OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING 
NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE 
SOFTWARE AND USER DOCUMENTATION AND RETURNING THE SAME TO SP.  

(b) NEITHER SP NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS 
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OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM SP OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES 
DISCLAIMED BY SP AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL 
ACTUAL OR ALLEGED DAMAGES IN CONNECTION WITH THE USE OF THE 
SOFTWARE AND USER DOCUMENTATION. THE ESSENTIAL PURPOSE OF THE 
LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE 
RISKS AS PROVIDED ABOVE. 

 
8. U.S. GOVERNMENT RESTRICTED RIGHTS  

 
This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by StructurePoint, LLC, 5420 Old Orchard Road, 
Skokie, Illinois, 60077. U.S. under license from Portland Cement Association (PCA). 
Government rights to use, modify, release, reproduce, perform, display or disclose this computer 
software and computer software documentation are subject to the restrictions of DFARS 
227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June 1995), or the Restricted Rights 
provisions of FAR 52.227-14 (June 1987) and FAR 52.227-19 (June 1987), as applicable. 

 
9. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this 
Agreement may be brought by Customer more than two years after the cause of such action has 
arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted 
herein or the Software or User Documentation by operation of law or otherwise without the prior 
written consent of SP. Any attempt to do any of the foregoing without SP’s consent is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of SP are unique and that, if Customer breaches this Agreement, SP may not have 
an adequate remedy at law and SP may enforce its rights hereunder by an action for damages 
and/or injunctive or other equitable relief without the necessity of proving actual damage or 
posting a bond therefore. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
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COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure 
to the benefit of the personal and legal representatives, permitted successors, and permitted 
assigns of the parties hereto.  

(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this Agreement 
shall be construed as cumulative and no one of them exclusive of any others or of any other legal 
or equitable remedy that said party or parties might otherwise have in the event of breach or 
default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in 
any way impair its rights to any other right or remedy until all obligations imposed on a party or 
parties have been fully performed. 

(i) No waiver by Customer, SP or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given 
a neutral interpretation and any ambiguity or uncertainty herein should not be construed against 
any party hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

(l) Except as set forth herein, this Agreement may be modified or amended only by a written 
instrument signed by a duly authorized representative of SP and Customer. 
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STRUCTUREPOINT 
SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE 
USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY 
DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE 
THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND 
RETURN THE SOFTWARE AND USER DOCUMENTATION TO SP FOR REFUND 
CONSIDERATION WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND 
USER DOCUMENTATION. 
STRUCTUREPOINT, LLC. 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER SP), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. 
SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY SP 
DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF SP (HEREAFTER DEALER). 
WHILE SP HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
SP AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT SP IS UNDER NO OBLIGATION TO 
PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL SP OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR 
OTHER DAMAGES, EVEN IF SP OR DEALER (IF ANY) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY 
THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED "INFRINGEMENT"; 
OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE OR 
USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR 
NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE 
SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, 
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MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO 
PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR 
USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S 
RESPONSIBILITIES; (5) SP NOT PROVIDING UPDATES, BUG FIXES OR CORRECTIONS 
TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) LABOR, 
EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR 
USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY 
CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, 
INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE WORK RELATED 
TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH 
AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER 
ACTS OF GOD. MOREOVER, IN NO EVENT SHALL SP BE LIABLE FOR WARRANTIES, 
GUARANTEES, REPRESENTATIONS OR ANY OTHER UNDERSTANDINGS BETWEEN 
CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER 
DOCUMENTATION. 
THIS SOFTWARE AND USER DOCUMENTATION IS LICENSED TO YOU BY 
STRUCTUREPOINT, LLC. AN ILLINOIS LIMITED LIABILITY COMPANY. IN NO EVENT 
SHALL PORTLAND CEMENT ASSOCIATION (PCA) BE LIABLE FOR: (A) LOSS OF PROFITS, 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL 
OR OTHER DAMAGES, EVEN IF PCA, STRUCTUREPOINT OR ANY OTHER PERSON HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST 
YOU BY ANY THIRD PARTY; OR (C) ANY DAMAGES WHATSOEVER, INCLUDING 
DAMAGES CAUSED BY OR ATTRIBUTABLE TO (1) DELAY IN DELIVERY OF THE 
SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE 
PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF 
THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, 
MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO 
PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER 
DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S 
RESPONSIBILITIES; (5) STRUCTUREPOINT FAILING TO PROVIDE UPDATES, BUG FIXES 
OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) 
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE 
OR USER DOCUMENTATION CAUSED BY OR ATTRIBUTABLE TO (a) ACCIDENT, (b) 
NEGLIGENCE OR ABUSE BY YOU OR ANY OTHER PERSON, (c) ACTS OF THIRD PERSONS 
INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER 
CORREC-TIVE WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTER-
NAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) 
FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL 
PCA BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER 
UNDERSTANDINGS BETWEEN YOU AND STRUCTUREPOINT OR ANY OTHER PERSON 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. YOU AGREE THAT 
STRUCTUREPOINT IS SOLELY RESPONSIBLE FOR YOUR USE OF OR INABILITY TO USE 
THE SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND SP AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY SP'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER 
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DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL 
NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by SP, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; (3) 
reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by SP. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in SP. Customer may use the Software at only 
one designated workstation at Customer's site at any given time. Customer may not transmit the 
Software electronically to any other workstation, computer, node or terminal device whether via a 
local area network, a wide area network, telecommunications transmission, the Internet or other 
means now known or hereafter created without prior written permission by SP.  

(B) CUSTOMER ACKNOWLEDGES THAT THE REGISTRATION PROCESS FOR THE 
SOFTWARE RESULTS IN THE GENERATION OF A UNIQUE LICENSE KEY. ONCE 
THE LICENSE KEY IS ENTERED DURING THE INSTALLATION PROCESS, THE 
SOFTWARE WILL ONLY WORK ON THE COMPUTER ON WHICH THE 
SOFTWARE IS INITIALLY INSTALLED. IF YOU NEED TO DEINSTALL THE 
SOFTWARE AND REINSTALL THE SOFTWARE ON A DIFFERENT COMPUTER, 
YOU MUST CONTACT SP TO OBTAIN THE NECESSARY REINSTALLATION 
PROCEDURES.  

 
2. CHARGES AND PAYMENTS  

All payments for the Software and User Documentation shall be made to either SP or Dealer (if 
any), as appropriate. 

 
3. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, 
copies or otherwise uses the Software or User Documentation until it is terminated by Customer, 
by Dealer (if any) on behalf of Customer or SP or by SP as set forth herein.  

(b) This Agreement may be terminated by SP without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to SP.  

 
4. BACKUP AND REPLACEMENT COPIES  

 
Customer may make one copy of the Software media for back-up and archival purposes only, 
provided SP's copyright and other proprietary rights notices are included on such copy. Customer 
shall request additional copies from SP if required. 

 
5. PROTECTION AND SECURITY  
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(a) Customer shall not provide or otherwise make available any of the Software or User 
Documentation in any form to any person other than employees of Customer with the need to 
know, without SP's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of SP. Upon termination of 
this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon SP’s request, Customer shall certify its compliance in writing 
with the foregoing to SP. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If SP prevails in an action against Customer for breach of the provisions of this Section 5, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by SP in 
connection with such action in addition to any award of damages. 

 
6. CUSTOMER'S RESPONSIBILITIES  

 
The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) 
all results obtained from use of the Software and User Documentation; and (d) the selection, use 
of, and results obtained from any other software, programming equipment or services used with 
the Software or User Documentation. 

 
7. LIMITED WARRANTIES  

 
SP and Dealer (if any) warrants to Customer that: (a) SP and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted 
hereunder; (b) the Software and User Documentation provided hereunder is SP's most current 
production version thereof; and (c) the copy of the Software provided hereunder is an accurate 
reproduction of the original from which it was made.  

 
8. INFRINGEMENT  

 
(a) SP shall defend Customer against a claim that the Software or User Documentation furnished 
and used within the scope of the license granted hereunder infringes a U.S. patent or U.S. 
registered copyright of any third party that was issued or registered, as applicable, as of the date 
Customer clicked the “I AGREE” below or installed, copied or otherwise began using the 
Software or User Documentation, and SP shall pay resulting costs, damages, and attorneys' fees 
finally awarded, subject to the limitation of liability set forth in Section 9 entitled "Limitation of 
Remedy," provided that: 

1. Customer promptly notifies SP in writing of the claim. 
2. SP has sole control of the defense and all related settlement negotiations.  
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3.  If such claim has occurred or in SP's opinion is likely to occur, Customer shall permit SP at its 
sole option and expense either to procure for Customer the right to continue using the Software 
or User Documentation or to replace or modify the same so that it becomes noninfringing. If 
neither of the foregoing alternatives is reasonably available in SP's sole judgment, Customer 
shall, on one month's written notice from SP, return to SP the Software and User Documentation 
and all copies thereof.  

(b) SP shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any 
claim based upon (1) use of other than a current unaltered release of the Software or User 
Documentation, or (2) the combination, operation or use of any Software or User Documentation 
furnished hereunder with any other software, documentation or data if such infringement would have 
been avoided but for the combination, operation or use of the Software or User Documentation with 
other software, documentation or data. 
(c) The foregoing states the entire obligation of SP and Customer’s sole remedy with respect to 
infringement matters relating to the Software and User Documentation. 
 
9. LIMITATION OF REMEDY  

(a) SP'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE 
REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF 
ANY SOFTWARE OR USER DOCUMENTATION, SP, DEALER (IF ANY), OR ANY 
OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, 
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE 
LIMITED TO THE AMOUNT PAID TO SP OR DEALER (IF ANY) FOR THE SOFTWARE 
AND USER DOCUMENTATION.  

(b) NEITHER SP NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF 
THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM SP OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED 
BY SP AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR 
ALLEGED DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY 
PROVIDED HEREUNDER. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY 
PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED 
ABOVE. 

 
10. U.S. GOVERNMENT RESTRICTED RIGHTS  

 
This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by StructurePoint, LLC. 5420 Old Orchard Road, 
Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce, perform, 
display or disclose this computer software and computer software documentation are subject to 
the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June 1995), 
or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 52.227-19 (June 
1987), as applicable. 
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11. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this 
Agreement may be brought by Customer more than two years after the cause of such action has 
arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license 
granted herein or the Software or User Documentation by operation of law or otherwise without 
the prior written consent of SP. Any attempt to do any of the foregoing without SP’s consent is 
void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of SP are unique and that, if Customer breaches this Agreement, SP may not have 
an adequate remedy at law and SP may enforce its rights hereunder by an action for damages 
and/or injunctive or other equitable relief without the necessity of proving actual damage or 
posting a bond therefor. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and 
inure to the benefit of the personal and legal representatives, permitted successors, and permitted 
assigns of the parties hereto.  

(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this 
Agreement shall be construed as cumulative and no one of them exclusive of any others or of any 
other legal or equitable remedy that said party or parties might otherwise have in the event of 
breach or default in the terms hereof. The exercise of one right or remedy by a party or parties 
shall not in any way impair its rights to any other right or remedy until all obligations imposed on 
a party or parties have been fully performed. 
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(i) No waiver by Customer, SP or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given a 
neutral interpretation and any ambiguity or uncertainty herein should not be construed against any 
party hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent. 

(l) Except as set forth herein, this Agreement may be modified or amended only by a written 
instrument signed by a duly authorized representative of SP and Customer. 

 



 

Chapter 1  
Introduction 

pcaColumn is a software program for the design and investigation of reinforced 
concrete sections subject to axial and flexural loads. The section can be 
rectangular, round or irregular, with any reinforcement layout or pattern. 
Slenderness effects can be considered. 

The program offers investigation of irregularly shaped, reinforced concrete column 
sections that may contain openings or boundary elements. Widely used for design 
of shear walls, bridge piers as well as typical framing elements in buildings, 
pcaColumn can investigate sections that are impossible to find on design charts or 
do by hand calculations. You can obtain the P-M interaction diagrams from both 
uniaxial and biaxial runs, as well as the Mx-My moment contour plots from biaxial 
runs for even the most irregular column and shearwall sections. Slenderness 
effects producing magnified moments may be included in the investigation. 

Program Features 
• ACI 318-05, ACI 318-02, CSA A23.3-04, and CSA A23.3-94 

• English and SI units 

• Design and investigation run options 

• Uniaxial or biaxial flexure combined with axial load 

• Rectangular, circular, and irregular section geometry 

• Non-slender and sway or non-sway slender columns 

• Complete P-M and Mx-My interaction diagrams 

• Customizable view of interaction diagrams 

• Superposition of interaction diagram from a different run 

• Factored, unfactored, axial, and control points loading 

• Binary (COL) and text (CTI) input file formats 
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• Graphical input for irregular sections 

• Imports geometry, reinforcement, and loads from text files 

• Exports section to DXF files 

• Exports P-M diagrams, Mx-My diagrams and 3D failure surface to TXT and 
CSV files 

• GUI (Graphical User Interface) and batch (command prompt) mode runs 

• Reports neutral axis location and maximum steel strain corresponding to 
section capacity 

• Reports strength reduction factors in text output 

Program Capacity 
• 10,000 reinforcing bars within a section.  

• 10,000 exterior points that define the geometric outline of the cross section 
(pcaSection module).  

• 10,000 interior points that define an opening in the cross section 
(pcaSection module).  

• 5,000 factored load entries, each consisting of an axial load, a moment 
about the x-axis, and a moment about the y-axis.  

• 50 service load entries, each consisting of dead, live, wind, earthquake, and 
snow axial loads, moments at column top about the x and y axes, and 
moments at column bottom about the x and y axes. 

• 50 load combinations. 

System Requirements 

Operating systems  
• Windows 98 SE 

• Windows ME 

• Windows NT4 

• Windows 2000 
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• Windows XP 

Minimum Requirements   
• 100 MHz processor 

• 32 MB of RAM memory 

• 50 MB of free hard disk space for program installation 

Recommended Options   
• Most recent OS service pack installed 

Terms 
The following terms are used throughout this manual. A brief explanation is given 
to help familiarize you with them. 

 
Windows refers to the Microsoft Windows environment version 3.1 or 

higher. 
 

[ ] indicates metric equivalent 
 

Click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button (unless 
instructed to use the right-mouse button). 
 

Double-click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button twice in 
quick succession. 
 

Conventions 
To help you locate and interpret information easily, the pcaColumn manual 
adheres to the following text format. 

Italic indicates a glossary item, or emphasizes a given word or 
phrase. 

Bold indicates the name of a menu or a menu item command such 
as File or Save. 



 

1-4  Introduction 

Mono-space indicates something you should enter with the keyboard. For 
example “c:\*.txt”. 

KEY + KEY indicates a key combination. The plus sign indicates that you 
should press and hold the first key while pressing the second 
key, then release both keys. For example, “ALT + F” 
indicates that you should press the “ALT” key and hold it 
while you press the “F” key. then release both keys. 

SMALL CAPS Indicates the name of an object such as a dialog box or a 
dialog box component. For example, the OPEN dialog box or 
the CANCEL or MODIFY buttons. 

Installing, Purchasing and Licensing pcaColumn 
For instructions on how to install, purchase and license pcaStructurePoint software 
please refer to our Software Quick Start Guide. 



 

Chapter 2  
Method of Solution 

A – Definitions and Assumptions 
1. The analysis of the reinforced concrete section performed by pcaColumn 

conforms to the provisions of the Strength Design Method1 and Unified 
Design Provisions2 and is based on the following assumptions.  

a) All conditions of strength satisfy the applicable conditions of equilibrium 
and strain compatibility3 

b) Strain in the concrete and in the reinforcement is directly proportional to 
the distance from the neutral axis4  

c) The maximum usable (ultimate) strain at the extreme concrete 
compression fiber is assumed equal to 0.003 for ACI codes5 and 0.0035 
for CSA codes6 unless otherwise specified by the user 

d) A uniform rectangular concrete stress block is used. For ACI code7, the 
maximum uniform concrete compressive stress, cf , is '

c0.85f  and the 
block depth is 1cβ , where c  is the distance from the extreme 
compression fiber to the neutral axis and 1β  is described in item 4 below. 
For CSA8, cf is taken as: 

( )' ' '
c c c cf 0.85 0.0015f f 0.67f= − ≥ , where '

cf  is in MPa 

Both cf  and 1β  can be modified by the user. 

                                                           
1 For the CSA A23.3-04 (Ref. [3]) and CSA A23.3-94 (Ref. [4]) 
2 For ACI 318-05 (Ref. [1]) and ACI 318-02 (Ref. [2]); also see notes on 8.1.2 in Ref. [6] 
3 ACI 318-05, 10.2.1; ACI 318-02, 10.2.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1 
4 ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; CSA A23.3-04, 10.1.2; CSA A23.3-94, 10.1.2 
5 ACI 318-05, 10.2.3; ACI 318-02, 10.2.3 
6 CSA A23.3-04, 10.1.3; CSA A23.3-94, 10.1.3 
7 ACI 318-05, 10.2.6, 10.2.7; ACI 318-02, 10.2.6, 10.2.6 
8 ACI 318-05, 10.2.1; ACI 318-02, 10.2.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1 
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e) Concrete displaced by the reinforcement in compression is deducted from 
the compression block9 
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Figure 2-1 Analysis of Reinforced Section 

f) For the reinforcing steel, the elastic-plastic stress-strain distribution is 
used10. Stress in the reinforcing steel below the yield strength, yf , is 
directly proportional to the strain. For strains greater than that 
corresponding to the yield strength, the reinforcement stress remains 
constant and equal to yf . 

g) Tensile strength of concrete is neglected11. 
h) Reinforcement bars are located within section outline. 

                                                           
9 For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [2]) and with Eq. 10-10 in CSA 
codes (Refs. [3], [4]) 
10 ACI 318-05, 10.2.4; ACI 318-02, 10.2.4; CSA A23.3-04, 8.5.3.2; CSA A23.3-94, 8.5.3.2 
11 ACI 318-05, 10.2.5; ACI 318-02, 10.2.5; CSA A23.3-04, 10.1.5; CSA A23.3-94, 10.1.5 



 

Method of Solution  2-3 

2. The modulus of elasticity of concrete, cE , is computed as follows (unless 
otherwise specified by the user): 

'
c cE 57,000 f= , for the ACI code12 where '

cf  and cE  are in psi, 

'
c cE 4,700 f= , for the ACI code13 where '

cf  and cE  are in MPa. 

For the CSA standard14, '
c cE 3,518 f 7,355= + , where '

cf  and cE  are in 
MPa. 

3. The modulus of elasticity of reinforcing steel15, sE , is taken as 29,000 ksi 
(200,000 MPa) unless otherwise specified by the user. 

4. The ratio of the concrete compression block depth to the distance between the 
extreme compression fiber and the neutral axis, 1β , is computed as follows 
(unless otherwise specified by the user): 

'
1 c0.65 1.05 0.05f 0.85≤ β = − ≤ , for the ACI code16 where '

cf  is in ksi, 
'

1 c0.65 (149 f ) /140 0.85≤ β = − ≤ , for the ACI code17 where '
cf  is in MPa. 

For the CSA standard18, '
1 c0.97 0.0025f 0.67β = − ≥ , where '

cf  is in MPa. 

5. Stress in the reinforcement is computed based on the strain at the centroid of 
each reinforcing bar. 

6. All moments are referenced to the geometric centroid of the gross concrete 
section (neglecting the reinforcement). 

7. For the ACI codes, the nominal (unreduced) capacity of the section is first 
computed. Then, the nominal capacity is reduced to the design capacity using 

                                                           
12 ACI 318-05, 8.5.1; ACI 318-02, 8.5.1 
13 ACI 318M-05, 8.5.1; ACI 318M-02, 8.5.1 
14 CSA A23.3-04, 8.6.2.3, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6 (with γc = 2400 kg/m3) 
15 ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI 318M-05, 8.5.2; ACI 318M-02, 8.5.2; CSA A23.3-04, 
8.5.4.1; CSA A23.3-94, 8.5.4.1 
16 ACI 318-05, 10.2.7.3; ACI 318-02, 10.2.7.3 
17 ACI 318M-05, 10.2.7.3; ACI 318M-02, 10.2.7.3 
18 CSA A23.3-04, 10.7.1(c); CSA A23.3-94, 10.7.1(c) 
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the strength reduction factor, φ , the value of which is calculated based on the 
net tensile steel strain, tε , in the following way19:  

For columns with spiral reinforcement 

( )

t

t y s
y y t

y s

t y y

0.9 if 0.005 (tension controlled sec tion)

0.20 f / E
0.70 if f / E 0.005 (transition sec tion)

0.005 f / E

0.70 if f / E (compression controlled sec tion)

⎧
⎪ ε ≥
⎪
⎪

ε −⎪⎪φ = + < ε <⎨ −⎪
⎪
⎪ ε ≤⎪
⎪⎩

For other columns 

( )

t

t y s
y y t

y s

t y y

0.9 if 0.005 (tension controlled sec tion)

0.25 f / E
0.65 if f / E 0.005 (transition sec tion)

0.005 f / E

0.65 if f / E (compression controlled sec tion)

⎧
⎪ ε ≥
⎪
⎪

ε −⎪⎪φ = + < ε <⎨ −⎪
⎪
⎪ ε ≤⎪
⎪⎩

For the CSA standards, the program calculates the factored resistance directly 
using the factored compressive concrete strength20, '

c cfφ , and the factored 
forces in reinforcement bars21, s iSφ . The material resistance factor for 
concrete, cφ , equals 

c

0.6 for CSA A23.3-94
0.65 for CSA A23.3-04 (cast-in-place)
0.70 for CSA A23.3-04 (precast)

⎧
⎪φ = ⎨
⎪
⎩

 

The material resistance factor for steel, sφ , is equal to 0.90. 

                                                           
19 ACI 318-05, 9.3.2, 10.3.3, 10.3.4; ACI 318-02, 9.3.2, 10.3.3, 10.3.4 
20 CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2 
21 CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3 
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Additionally, the design axial capacity (for all ACI and CSA standards) is 
capped22 at 0.85 of the maximum axial capacity for sections with spiral 
reinforcement or at 0.80 for sections with tie reinforcement. 

8. In the investigation mode the program will calculate capacity for any provided 
area of reinforcement. However, if the reinforcement area falls below the 
code-specified23 minimum of 0.01 times the gross area, Ag, then two options, 
Architectural or Structural, are available. 

By default Architectural option is selected for which the capacity of the 
section is reduced. For the ACI codes, the reduction results from multiplying 
the maximum concrete stress, '

cf , by the ratio of reinforcement area to 
0.01Ag. This produces the same effect as reducing the effective concrete 
area24 to achieve ratio of reinforcement area to gross concrete area equal to 
0.01. For the CSA standards25, the factored axial and flexural resistances are 
multiplied by ratio ( )t0.5 1 / 0.01+ ρ  for the 04 edition and t / 0.01ρ  for the 94 
edition. 
For Structural option, the section is treated “as is” without any reductions in 
capacity. This option is provided for informational purposes only, since per all 
codes supported by pcaColumn, capacity of compression members with 
reinforcement area less than 0.01Ag has to be reduced and areas below 
0.005Ag are not allowed. 

9. Under the Design option, the reinforcement ratio cannot be less than 1.0% if 
Structural column type is selected in design criteria and 0.5% in case of 
Architectural column type. For Architectural type, the capacity of the 
designed column is reduced as described above. Additionally, User Defined 
type is provided in the design criteria, which allows designs with 
reinforcement ratios not less than 0.1%. No reduction in capacity is applied 
for User Defined column type. 

10. Maximum reinforcement ratio26 for Structural and Architectural options in 
both Investigation and Design modes is 8%. For User Defined type in the 
Design mode the maximum reinforcement ratio is set to 20%. 

                                                           
22 ACI 318-05, 10.3.6; ACI 318-02, 10.3.6; CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4 
23 ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1 
24 ACI 318-05, 10.8.4; ACI 318-02, 10.8.4 
25 CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5 
26 ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-04, 10.9.2; CSA A23.3-94, 10.9.2 
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Figure 2-2 Reduction factors for Flexure and Axial Loads per ACI code 

B – Sign Convention 
1. Positive axial forces are compressive and negative axial forces are tensile. 
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Figure 2-3 Positive axial force and bending moments (internal forces) 

2. Looking in plan at the section with z-axis pointing outwards, the positive x-
axis points to the right and the positive y-axis points up. For this section, 
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vectors of positive bending moments have the same orientation as their 
corresponding axes x and y. Thus, a positive bending moment about the x-
axis, Mx, produces tension at the top face of the section and compression at 
the bottom face. A positive bending moment about the y-axis, My, produces 
tension at the left face of the section and compression at the right face. 

3. If service loads are input, moment loads at the upper (top) and lower (bottom) 
ends of the column are needed. Top and bottom moment loads of opposite 
signs produce single curvature bending. Top and bottom moment loads of the 
same sign produce double curvature bending. 

z

z

Mx

Mx

My

My

z My

Mx

My

Mx

 
Figure 2-4 Positive moment loads (external forces) 

Positive moment loads at the upper end of the column coincide with positive 
bending moments. However, at the lower end, positive moment loads produce 
effects opposite to positive bending moments. Therefore pcaColumn changes 
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the sign of the service moment at the lower end to convert it from a moment 
load to a bending moment. 
Axial load is assumed to be constant so it is input only as for the upper end 
where positive axial load coincides with positive axial force. 

4. If factored loads are input, they are considered to be applied at a section 
pointing upwards so that they have the same orientations as positive axial 
force and positive bending moments. 

C – Section Investigation 
1. The computations performed when investigating a section depend on the 

selected load mode: 

a) Factored loads – for the axial load of each load point, the moment 
capacity and the ratio of design-to-applied moment are computed. For 
a biaxial run, the computed Mx and My moment capacities are at the same 
angle as that produced by the applied Mx and My moments. In uniaxial 
case the program also reports the depth of neutral axis and maximum 
steel strain corresponding to the calculated moment capacity. For the ACI 
code, the value of strength reduction factor is also reported. 
pcaColumn allows defining upto 50 load combinations. The user has full 
control over the combinations. The program contains predefined (built 
into the program) default primary load combinations for the supported 
codes. These default combinations are created when starting a new 
project. The default load combinations of the Dead(D), Live (L), Wind 
(W), Earthquake (E) and Snow (S) loads considered by the program are 
shown below. For the ACI 318-02 and 05 codes27: 
U1 = 1.4D 
U2 = 1.2D + 1.6L + 0.5S 
U3 = 1.2D +1.0L + 1.6S 
U4 = 1.2D + 0.8W + 1.6S 
U5 = 1.2D +1.0L + 1.6W + 0.5S 
U6 = 0.9D + 1.6W 
U7 = 1.2D – 0.8W + 1.6S 
U8 = 1.2D +1.0L – 1.6W + 0.5S 
U9 = 0.9D – 1.6W 

                                                           
27 ACI 318-05, 9.2; ACI 318-02, 9.2; 
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U10 = 1.2D +1.0L +1.0E – 0.2S 
U11 = 0.9D +1.0E 
U12 = 1.2D +1.0L – 1.0E + 0.2S 
U13 = 0.9D – 1.0E 
For the CSA A23.3-94 code28: 
U1 = 1.25D 
U2 = 1.25D + 1.5L 
U3 = 1.25D + 1.05L + 1.05W 
U4 = 1.25D + 1.5W 
U5 = 0.85D + 1.5W 
U6 = 1.0D +1.0L + 1.0E 
U7 = 1.0D + 1.0E 
U8 = 1.25D + 1.05L – 1.05W 
U9 = 1.25D – 1.5W 
U10 = 0.85D – 1.5W 
U11 = 1.0D + 1.0L – 1.0E 
U12 = 1.0D – 1.0E 
For the CSA A23.3-04 code29: 
U1 = 1.4D 
U2 = 1.25D + 1.5L 
U3 = 1.25D + 1.5L + 0.5S 
U4 = 1.25D + 1.5L + 0.4W 
U5 = 1.25D + 1.5L – 0.4W 
U6 = 0.9D + 1.5L 
U7 = 0.9D + 1.5L + 0.5S 
U8 = 0.9D + 1.5L + 0.4W 
U9 = 0.9D + 1.5L – 0.4W 
U10 = 1.25D + 1.5S 
U11 = 1.25D + 0.5L + 1.5S 
U12 = 1.25D + 0.4W + 1.5S 
U13 = 1.25D – 0.4W + 1.5S 
U14 = 0.9D + 1.5S 

                                                           
28 CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies) 
29 CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [5], Table 4.1.3.2 
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U15 = 0.9D + 0.5L + 1.5S 
U16 = 0.9D + 0.4W + 1.5S 
U17 = 0.9D – 0.4W + 1.5S 
U18 = 1.25D + 1.4W 
U19 = 1.25D + 0.5L + 1.4W 
U20 = 1.25D + 1.4W + 0.5S 
U21 = 1.25D – 1.4W 
U22 = 1.25D + 0.5L – 1.4W + 0.5S 
U23 = 1.25D – 1.4W + 0.5S 
U24 = 0.9D + 0.5L + 1.4W 
U25 = 0.9D + 0.5L + 1.4W 
U26 = 0.9D + 1.4W + 0.5S 
U27 = 0.9D – 1.4W 
U28 = 0.9D + 0.5L – 1.4W 
U29 = 0.9D – 1.4W + 0.5S 
U30 = 1.0D + 1.0E 
U31 = 1.0D + 0.5L + 1.0E + 0.25S 
U32 = 1.0D – 1.0E 
U33 = 1.0D + 0.5L – 1.0E + 0.25S 

b) Service loads – the program calculates the factored loads using the input 
load combinations. If slenderness effects are to be checked and the 
column is found to be slender, the applied moments are magnified 
according to Procedures E and F. For each calculated factored load, the 
same computations described in (a) above are performed.  

c) Control points – for several key points on the interaction diagram, the 
program calculates axial load and moment capacity together with the 
neutral axis depth and maximum steel strain corresponding to the 
respective moment capacity. For ACI code, strength reduction factor is 
also reported. The following key points are used by the program: 
maximum compression, allowable compression, point where steel stress 
is zero, point where steel stress is 0.5 yf , balanced point, pure flexure and 
maximum tension. For ACI code, an additional control point is 
introduced where maximum steel strain is equal to 0.005 (tension control 
limit). 
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Figure 2-5 Interaction Surface for Combined Axial Load and Biaxial 
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d) Axial loads – for each input axial load, the program calculates the 
positive and negative moment capacities together with the corresponding 
neutral axis depths and maximum steel strains. For ACI code, strength 
reduction factors are also reported. 

2. The program also computes the interaction diagram (uniaxial runs) or the 
three-dimensional failure surface (biaxial runs) of the input section. The 
values of maximum compressive axial load capacity and maximum tensile 
load capacity are computed. These two values set the range within which the 
moment capacities are computed for a predetermined number of axial load 
values.  

a) For uniaxial runs, positive and negative moment capacities about only the 
selected axis are computed. Moment capacities about the orthogonal axis 
are ignored. To compute the moment capacity at a certain level of axial 
load, the neutral axis angle is held constant, parallel to the selected axis. 
The neutral axis depth is adjusted to arrive at the desired axial load 
capacity. This is done for all the predetermined values of axial load.  

b) For biaxial runs, the same predetermined values of axial load are utilized. 
For each level of axial load, the section is rotated in 10-degree increments 
from 0 degrees to 360 degrees and the Mx and My moment capacities are 
computed. Thus for each level of axial load, an Mx-My contour is 
developed. Repeating this for the entire range of axial loads, the three-
dimensional failure surface is computed. 

Also for each point on the interaction diagram or on the three-dimensional 
failure surface, the program calculates the location of the neutral axis 
(expressed in terms of depth and angle of the neutral axis), maximum steel 
strain, and (for ACI codes only) the strength reduction factor. 

D – Section Design 
1. Based on the specified minimum, maximum and increment specified for the 

section and the reinforcing bars, the program selects the smallest section with 
the least amount of reinforcement for which the load-moment capacity 
exceeds the applied loads. If service loads are input, they are factored using 
the input load combinations. Depending on the design criteria the user selects, 
the least amount of reinforcement the program searches for means either the 
smallest number of bars or the smallest steel area. 

2. The program starts the design by trying the smallest section (minimum 
dimensions) and the least amount of reinforcing bars. The program verifies 
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that the ratio of provided reinforcement is always within the specified 
minimum and maximum ratios. Furthermore, the bar spacing is always kept 
greater than or equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 
mm] (unless otherwise specified by the user)30. 

3. A section fails the design if, for the design axial load, the ratio of design-to-
applied moment is less than 1.0 (unless otherwise specified in the Design 
Criteria box).  

4. Once a section passes the design, its capacity is computed and the 
computations explained in Procedure C above are performed. 

E – Moment Magnification for Nonsway Columns 
1. If properties of framing members are input, pcaColumn computes the non-

sway condition effective length factor, bk , as the smaller of31:  

( )A B0.7 0.05 1.0+ ψ + ψ ≤  

min0.85 0.05 1.0+ ψ ≤  

Where ψ  is the ratio of ( )EI / LΣ  of columns to ( )EI / LΣ of beams in 
a plane at one end of the column, Aψ  and Bψ  are the values of ψ  at the 
upper end and the lower end of the column, respectively, and minψ  is the 
smaller of Aψ  and Bψ . 

The value of bk must always be between 0.5 and 1.0. The moment of inertia 
used in computing ψ  is the gross moment of inertia multiplied by the cracked 
section coefficients32 (specified in the Slenderness Factors box). 

2. The smaller and larger factored column end moments 1M  and 2M , 
respectively, are computed. 1M  is positive if the column is bent in single 
curvature and is negative if the column is bent in double curvature. 2M  is 
always positive.  

3. For the ACI code, slenderness effects will be considered if33  

                                                           
30 ACI 318-05 7.6.3; ACI 318-02 7.6.3 
31 ACI 318-05 R10.12.1; ACI 318-02 R10.12.1 
32 ACI 318-05 10.11.1, 10.12.1; ACI 318-02 10.11.1, 10.12.1; CSA A23.3-04 10.14.1.2, 10.15.1; 
CSA A23.3-94 10.14.1, 10.15.1 
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where ul  is the unsupported column length and gIr
A

=  is the radius of 

gyration. The ratio 1 2M / M  is always greater than or equal to -0.5. If both 
moments are equal to zero, the program conservatively assumes the ratio of 

1 2M / M 1.0= . 

4. If the ratio uk l / r  exceeds 100, slenderness effects using this approximate 
procedure cannot be applied35. A more exact method must be used. In this 
case, the program issues a warning message and aborts design or investigation 
procedure36. 

5. The factor mC  is computed as37: 

1
m

2

MC 0.6 0.4 0.4
M

= + ≥ . 

If 1 2M M 0= = , the program assumes Cm to be equal to38 1.0. This is 
consistent with the assumption made above (in point 3). 

6. Assuming that only dead loads are sustained, the factor dβ  is computed as the 
ratio of maximum factored axial dead load to the total factored axial load for 
the load combination under consideration39. 

7. Flexural stiffness EI  is computed as40: 

                                                                                                                                      
33 ACI 318-05 10.12.2; ACI 318-02 10.12.2 
34 CSA A23.3-04 10.15.2; CSA A23.3-94 10.15.2 
35 ACI 318-05 10.11.5; ACI 318-02 10.11.5; CSA A23.3-04 10.13.2; CSA A23.3-94 10.13.2 
36 Interaction diagram will still be constructed but no design or investigation will be performed. 
37 ACI 318-05 10.12.3.1; ACI 318-02 10.12.3.1; CSA A23.3-04 10.15.3.2; CSA A23.3-94 10.15.3.1 
38 ACI 318-05 10.12.3.2; ACI 318-02 10.12.3.2 
39 ACI 318-05 10.11.1; ACI 318-02 10.0; CSA A23.3-04 2.3; CSA A23.3-94 10.0 
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where cE  is the modulus of elasticity of concrete, sE is the modulus elasticity 
of steel, gI is the gross moment of inertia of the concrete section, and seI  is 
the moment of inertia of reinforcement. 

8. The critical buckling load, cP , is computed as41: 

2

c 2
u

EIP
(k l )
π

= . 

9. The nonsway moment magnification factor, bδ , is computed as42: 

m
ns

u

m c

C 1.0P1
P

δ = ≥
−

φ

, 

where the member resistance factor, mφ , is equal to 0.75 (may be modified 
using the Slenderness Factors input box) and uP  is the factored axial load for 
the load combination under consideration. 

10. The moment due to minimum eccentricity, mine , is computed as43: 

min u minM P e= , where 

hemin 03.06.0 += , with h  in in, 

hemin 03.015 += , with h  in mm, 

and h  is the section dimension (diameter for circular sections) in the direction 
being considered.  

11. The magnified moment, cM , is the larger44 of ns 2Mδ  and ns minMδ . 

                                                                                                                                      
40 ACI 318-05 10.12.3 Eq. 10-11; ACI 318-02 10.12.3. Eq. 10-10; CSA A23.3-04 10.15.3 Eq. 10-18; 
CSA A23.3-94 10.15.3.1 Eq. 10-18 
41 ACI 318-05 10.12.3 Eq. 10-10; ACI 318-02 10.12.3 Eq. 10-10; CSA A23.3-04 10.15.3.1 Eq. 10-17; 
CSA A23.3-94 10.15.3 Eq. 10-17 
42 ACI 318-05 10.12.3 Eq. 10.9; ACI 318-02 10.12.3 Eq. 10.9; CSA A23.3-04 10.15.3.1 Eq. 10-
16;CSA A23.3-94 10.15.3 Eq 10-16 
43 ACI 318-05 10.12.3.2; ACI M318-05 10.12.3.2; ACI 318-02 10.12.3.2; ACI M318-02 10.12.3.2; 
CSA A23.3-04 10.15.3.1; CSA A23.3-94 10.15.3. 
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F – Moment Magnification for Sway Columns 
1. If properties of framing members are input, pcaColumn computes the sway 

condition effective length factor, k , using the following simplified 
equations45:  

if both ends are restrained and m 2ψ < , ( )m mk 0.05 20 1 1.0= − ψ + ψ ≥ , 

if both ends are restrained and m 2ψ ≥ , mk 0.9 1 1.0= + ψ ≥ ,  

if the upper end is hinged, Bk 2 0.3= + ψ , 

if the lower end is hinged, Ak 2 0.3= + ψ , 

if both ends are hinged, k 30= . 

Where ψ  is the ratio of ( )EI / LΣ  of columns to ( )EI / LΣ  of beams in 
a plane at one end of the column, Aψ  and Bψ are the values of ψ  at the 
upper end and the lower end of the column, respectively, and mψ  is the 
average of Aψ  and Bψ .  

An end is determined to be hinged if its ψ  is very large. This happens in the 
case where ( )EI / LΣ  of beams is too small (or zero) relative to the ( )EI / LΣ  
of columns at that end. In this case, the program outputs 999.9 for the value of 
ψ . The moment of inertia used in computing ψ  is the gross moment of 
inertia multiplied by the cracked section coefficients46 (specified in the 
Slenderness Factors input box).  

2. The smaller and larger factored non-sway column end moments 1nsM  
and 2nsM , respectively, are computed. These are factored moments due to 
dead, live, and snow loads assumed to cause no appreciable sidesway47. 1nsM  
is positive if the column is bent in single curvature and is negative if the 
column is bent in double curvature. 2nsM is always positive. 

                                                                                                                                      
44 ACI 318-05 10.12.3.2; ACI 318-02 10.12.3.2; CSA A23.3-04 10.15.3.1; CSA A23.3-94 10.15.3 
45 ACI 318-05 R10.12.1; ACI 318-02 R10.12.1 
46 ACI 318-05 10.11.1, 10.13.1; ACI 318-02 10.11.1, 10.13.1; CSA A23.3-04 10.14.1.2, 10.16.1; CSA 
A23.3-94 10.14.1, 10.16.1 
47 ACI 318-05 2.1; ACI 318-02 10.0; CSA A23.3-04 2.3; CSA A23.3-94 10.0 
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3. The smaller and larger factored sway column end moments 1sM  and 2sM , 
respectively, are computed. These are factored moments due to lateral loads 
(wind and earthquake). 1sM  is positive if the column is bent in single 
curvature and is negative if the column is bent in double curvature. 2sM  is 
always positive. 

4. For the ACI code48, slenderness effects will be considered if uk l / r 22.0≥ . 
For the CSA standard, all sway columns are designed for slenderness effects. 

5. If the ratio uk l / r  exceeds 100, slenderness effects using this approximate 
procedure cannot be applied49. A more exact method must be used. In this 
case, the program issues a warning message and aborts design or investigation 
procedure50. 

6. Flexural stiffness EI is calculated as51: 

c g s se

d

0.2E I E I
EI

1
+

=
+ β

 

where cE  is the modulus of elasticity of concrete, sE  is the modulus 
elasticity of steel, gI  is the gross moment of inertia of the concrete section, 

seI  is the moment of inertia of reinforcement and dβ  is taken as zero with the 
assumption that shear due to lateral loads is not sustained in most frames52. 

7. The critical buckling load, cP , is computed as53: 

( )

2

c 2
u

EIP
k l
π

= . 

8. The sway moment magnification factor, sδ , is computed as54: 

                                                           
48 ACI 318-05 10.13.2; ACI 318-02 10.13.2 
49 ACI 318-05 10.11.5; ACI 318-02 10.11.5; CSA A23.3-04 10.13.2; CSA A23.3-94 10.13.2 
50 Interaction diagram will still be constructed but no design or investigation will be performed. 
51 ACI 318-05 10.12.3 Eq. 10-11; ACI 318-02 10.12.3. Eq. 10-10; CSA A23.3-04 10.16.3.2, 10.15.3 
Eq. 10-18;; CSA A23.3-94 10.16.3.2, 10.15.3.1 Eq. 10-18 
52 Ref. [7] pp 581 (first paragraph from the bottom) 
53 ACI 318-05 10.12.3 Eq. 10-10; ACI 318-02 10.12.3 Eq. 10-10; CSA A23.3-04 10.16.3.2, 10.15.3.1 
Eq. 10-17; CSA A23.3-94 10.16.3.2, 10.15.3 Eq. 10-17 
54 ACI 318-05 10.13.4.3; ACI 318-0210.13.4.3; CSA A23.3-0410.16.3.2; CSA A23.3-94 10.16.3.2 
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where the member resistance factor, mφ , is equal to 0.75. 

uPΣ  is taken as the factored axial load for the load combination under 
consideration times the ratio u uP / PΣ , i.e.55 ( )u u u uP P P PΣ = Σ . 

cPΣ  is taken as the critical buckling load for the load combination under 
consideration times the ratio c cP / PΣ , i.e. ( )c c c cP P P PΣ = Σ . 

kφ  and the ratios u uP / PΣ  and c cP / PΣ  may be modified using the 
Slenderness Factors input box.  

9. If u

u
'
c g

l 35
r P

f A

>  , the magnified moment is computed as56: 

1 1ns s 1sM M M= + δ , 

2 2ns s 2sM M M= + δ . 

10. If u

u
'
c g

l 35
r P

f A

> , the nonsway moment magnification factor, bδ , is computed 

according to steps 1 through 9 as described in Procedure E above. In step 7, 
however, dβ  is computed for the load combination under consideration. The 
magnified moment is computed as57: 

( )1 b 1ns s 1sM M M= δ + δ , 

( )2 b 2ns s 2sM M M= δ + δ . 

                                                           
55 To minimize required input, the program uses one value of ratio ΣPu / Pu for all load combinations. 
However, the ratio can vary depending on the combination under consideration. In this case, it will be 
conservative to use the highest value of the ratio. 
56 ACI 318-05 10.13.3; ACI 318-02 10.13.3; CSA A23.3-04 10.16.2; CSA A23.3-94 10.16.2 
57 ACI 318-05 10.13.5; ACI 318-02 10.13.5; CSA A23.3-04 10.16.4; CSA A23.3-94 10.16.4 
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Chapter 3  
pcaColumn Interface 

Main Window 
Most windows have certain elements in common, such as a title bar and menus. 
Not all windows, however, have every element. To learn more about how to use 
window elements, refer to your Microsoft Windows manual. The following is a list 
of the pcaColumn window components. 

 

Control-Menu Box: 
The Control-menu box is located in the upper-left corner of the window and 
includes commands for sizing, moving, enlarging, restoring, and closing the 
window, as well as switching to other applications. To access the Control-menu 
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box using the mouse, click the left mouse button on the box; using the keyboard, 
press ALT+‘ ‘(space). 

Title Bar:  
The Title bar displays the name of the application (pcaColumn in this case), along 
with the name of the current data file in use. If the data have not been saved into a 
file, the word Untitled is displayed in the Title bar.  

Menu Bar:  
The Menu bar is located directly below the Title bar. It lists the available menus. A 
menu contains a list of commands or actions you can execute.  

Tool Bar:  
The Tool bar is located directly below the Menu bar. It contains a collection of 
buttons (or icons) that provide a shortcut to accessing the menu commands. The 
Tool bar buttons can only be accessed using the mouse.  

Information Bar:  
The Information bar is located on the left side of the pcaColumn window. The top 
part displays the column cross section. The bottom part is a list of selected input 
data echo.  

Graphics Area:  
The Graphics area covers most of the window. This is where the interaction 
diagram is shown.  

Status Bar:  
The Status bar is located along the bottom of the window. It displays important 
information such as units, design code, cursor position, and helpful messages. 
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File Menu 
The File menu is used for working with data files, printing results, and exiting the 
program.  

New (CTRL+N) 
Clears any input data and returns the data to 
the default values so that a new data file may 
be input. 

Open (CTRL+O) 
Opens an existing pcaColumn data file.  

Save (CTRL+S) 
Saves the changes you have made to the 
current data file under that same filename.  

Save As 
Names or renames a data file.  

Import (CTRL+I) 
Reads geometry, reinforcement or loads data from an ASCII (TXT) file.  

Export  
Exports interaction diagram and 3D failure surface to Comma-Separated Values 
(CSV) files (readable by most spreadsheet programs) or Tab-Delimited Text 
(TXT) files, or exports a column section to Drawing Exchange Format (DXF) file 
(readable by most CAD programs). 

Revert  
Discards any changes to the data and returns to the last version of saved data. This 
option will only be available if the file has been modified since the last file save.  

Print Results 
Displays Print dialog box and prints the results in the text form to the selected 
printer. 
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Print Screen (CTRL+P) 
Displays Print dialog box and prints the results similarly as they appear on the 
screen. 

Recent Data File List 
Provides quick access to up to four recently open data files. 

Exit  
Quits the pcaColumn program. If you have made any changes to your data and 
have not saved them, pcaColumn will prompt you whether you want to save or 
abandon any changes you have made before you exit. 

Input Menu  
The Input menu includes commands used to input the data needed to define 
a problem.  

General Information  
Input labels to identify the input and select from several 
options that control the run.  

Material Properties  
Input the material properties for concrete and reinforcement.  

Section  
Rectangular: Input the dimensions of a rectangular section. 

Circular: Input the dimension of a circular section. 

Irregular: Execute pcaSection to define an irregularly shaped section. 
See Chapter 6. 

Reinforcement  
All Sides Equal: Input a reinforcement pattern in which all the bars are of one 
size, and the number of bars is the same on all four sides of a rectangular layout or 
are equally spaced for a circular layout. Available for rectangular and circular 
sections. 
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Equal Spacing: Input a reinforcement pattern in which all bars are of one size and 
are uniformly spaced on all four sides of a rectangular layout. Available for 
rectangular sections only. 

Sides Different: Input a reinforcement pattern in which each one of the four sides 
of a rectangular section has a certain number of bars and a certain bar size. 
Available for rectangular sections only. 

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any 
size can be placed anywhere within the column section. 

Confinement: Input confinement-related data such as the capacity reduction 
factors and the size of ties associated with the longitudinal bar size. 

Design Criteria: Input parameters that govern the design of the section such as 
column type, minimum and maximum reinforcement ratio, bar selection criterion, 
minimum clear spacing, and design/required ratio. 

Slenderness  
Design Column: Input data needed for slenderness related to the column being 
considered. 

Column Above/Below: Input data needed for slenderness related to the columns 
above and below the design column. 

X-Beams: Input data needed for slenderness related to beams perpendicular to the 
x-axis framing into the design column. 

Y-Beams: Input data needed for slenderness related to beams perpendicular to the 
y-axis framing into the design column. 

Factors: Input factors that affect slenderness calculations. 

Loads  
Factored: Input factored axial loads and moments. This command is available for 
non-slender columns only. 

Service: Input service-level (dead, live, wind, earthquake, and snow) axial loads 
and moments about the active axis. Moments are input at the top and at the bottom 
of the column. This command must be used for slender columns. 

Control Points: If chosen, the program will compute key points on the interaction 
diagram. In addition, the splice regions are shown on the interaction diagram. This 
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option is available for short (non-slender) columns under the investigation option 
only and for uniaxial runs only. 

Axial Loads: Input a group of axial loads with an initial value, a final value, and 
an increment. This command is available for uniaxial short (non-slender) columns 
only. 

Load Combinations: Input the load factors and combinations used to combine the 
service loads.  

Flip/Rotate Section  
Flip an unsymmetrical section about an axis or rotate an irregular section (created 
in pcaSection). 

Solve Menu  
The Solve menu contains commands used to perform the design 
or investigation, trace through the design process, and send the 
output to a text file.  

Execute (F5)  
Executes the solver.  

Design Trace  
Toggles trace-through-a-design On and Off.  

Results File  
Toggles output-to-results-file On and Off. 

View Menu 
The View menu commands used to customize the display screen to suit your 
viewing needs, view the interaction diagram at a given angle, view the contour for 
a given axial load, superimpose an interaction diagram or a contour from another 
run, and view the results file.  

Redraw  
Redraws the displayed diagram or contour and clear any superimposed curves. 
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Copy Diagram to Clipboard (CTRL+C) 
Copies the displayed diagram or contour to clipboard so that in can be pasted in 
other applications . 

Information Bar  
Shows or hides the Information bar.  

Tool Bar  
Shows or hides the Tool bar.  

Status bar  
Shows or hides the Status bar.  

Grid  
Shows or hides the grid.  

Mx-My Diagram  
View a contour of the failure surface sliced at a constant axial load.  

P-M Diagram - Full 
View an interaction diagram sliced at a constant (Mx, My) angle drawn for both 
positive and negative moments. 

P-M Diagram - M positive 
View an interaction diagram sliced at a constant (Mx, My) angle drawn for the 
positive moments only. 

P-M Diagram - M negative 
View an interaction diagram sliced at a constant (Mx, My) angle drawn for the 
negative moments only. 

Next Load (Ctrl + Arrow Up) 
View an Mx-My interaction diagram for the factored load next to the one displayed 
currently on the interaction diagram. 
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Previous Load (Ctrl + Arrow Up) 
View an Mx-My interaction diagram for the factored load previous to the one 
displayed currently on the interaction diagram. 

Next Angle 
View a P-M interaction diagram at the (Mx, My) angle corresponding to factored 
load next to the one currently in the graphics area. 

Previous Angle 
View a P-M interaction diagram at the (Mx, My) angle corresponding to factored 
load previous to the one currently in the graphics area. 

Show Load Point Labels 
Show/Hide Load Point labels of factored loads input. 

Show Splice Lines 
Show the P-M splice lines corresponding to fs=0 and fs=0.5fy. 

Superimpose  
Superimpose a diagram from a previously saved run over the current diagram.  

Results (F6) 
View the results file after a successful run has been performed with the 
Solve | Results File option ON. 

Options 
The Options menu contains commands used to view or change 
pcaColumn’s default settings and reinforcement bar set.  

Startup Defaults 
View or Edit application startup default settings. 

Reinforcement 
View or Edit reinforcing bar set. 
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Help Menu  

Contents and Index  
Lists all the available help topics about the program.  

Using Help  
Provides help on using the Microsoft Windows help system.  

Check for Updates 
Checks if a newer version of the program is available. Internet connection is 
required. 

About pcaColumn 
Shows the version number of the program, the licensing information, and the 
copyright information. In the case of a trial license, the expiration date is given as 
well as the locking code which is needed to obtain a standalone license. 





 

Chapter 4  
Operating the Program 

This chapter is divided into sections that follow the order in which commands and 
options appear in the program. 

Creating a New Data File  
When pcaColumn is first loaded, the program is ready to obtain input for a new 
file. The data will not have a filename associated with it; therefore, Untitled 
appears in the Title bar.  

• Select File | New. This clears the screen and returns to the default settings 
of the program. If existing data have been changed prior to selecting the 
New command, pcaColumn asks if you want to save the data. At any time 
after starting a new file, use the File | Save As command to give the file a 
name. 

Opening an Existing Data File 
You can open pcaColumn data files that were previously saved to disk. pcaColumn 
reads files that have been saved in binary format (with COL extension) or text 
input format (with CTI extension).  

• Select File | Open. A dialog box appears. 

• All files with the COL extension contained in the current drive and 
directory are displayed in the FILE NAME list box. 

• To open a file that exists in another drive or directory, select the drive or 
directory you want from the Drives drop-down list or the Directories list 
box respectively. 

• To open a file in pcaColumn Text Input (CTI) format58, use FILE TYPE list 
box to select this type. 

                                                           
58 See Appendix for description of the CTI format 
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• From the FILE NAME list box, select the file to be opened, or simply type its 
name in the text box.  

• Choose the OK button. 

 

 

Saving the Data 

To save the data with the same filename:  
At anytime while editing a data file that has previously been saved under 
a filename, choose File | Save to save the changes under the same file name. 
Selecting the File | Save command before giving the data file a name displays the 
Save As dialog box.  

To give the data a new or different filename or to change input file format:  
• Select File | Save As. A dialog box appears. 

• All files with COL extension contained in the current drive and directory 
are displayed in the FILE NAME list box. 
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• To save the file to a drive or directory other than the default, select a 
different drive from the Drives drop-down list or a different directory from 
the Directories list box. 

• Use FILE TYPE list box to select either pcaColumn Input File (COL) or 
pcaColumn Text Input File (CTI). 

• In the FILE NAME text box, type a new filename. If no file extension is 
specified, an extension will be appended to the specified filename based on 
the selected file type. 

• Choose the OK button. 

 

Importing Data 
Geometry, reinforcement or load data may be imported 
from a text file. The import file must be saved in pure 
ASCII (text) format.59 

• Select File | Import. A dialog box appears. 

                                                           
59 See Appendix for description of the import file format 
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• Select the type of data you want to import: SERVICE LOADS, FACTORED 
LOADS, REINFORCEMENT OR GEOMETRY. 

• Choose the OK button. The Open Import file box is displayed. 

• All files with the TXT extension contained in the current drive and 
directory are displayed in the FILE NAME list box. 

• To open a file that exists in another drive or directory, select the drive or 
directory you want from the Drives drop-down list or the Directories list 
box respectively. 

• From the File Name list box, select the file to be opened, or simply type its 
name in the text box.  

• Choose the OK button. 

Exporting Data 
Once a successful run has been performed you may export points from the 
interaction diagram or 3D failure surface to a Comma-Separated Values (CSV) file 
or to a Tab Delimited Text file (TXT). These files can be read by most spreadsheet 
and mathematical programs where data produced by pcaColumn can be further 
analyzed and processed as needed the user. Coordinates of the points (P, Mx, My) 
are saved together with corresponding location of the neutral axis (depth and 
angle), maximum steel strain, and (for ACI code) strength reduction factor. Also, 
the column section can be exported to a file in Drawing Exchange Format (DXF) 
format that is readable by most CAD programs. 

• Select File | Export | Current Interaction Diagram to export P-M or Mx-
My diagram currently displayed on the screen. 

• To export 3D failure surface (biaxial runs only) select File | Export | 
3D Failure Surface. 

• To export column section to DXF file select File | Export | Column 
Section to DXF. 

• For interaction diagrams and 3D failure surface, use FILE TYPE list box to 
select either Comma-Separated Values (CSV) file or Tab Delimited Text 
file (TXT). For sections, only DXF format is available. 



 

Operating the Program  4-5 

• In the FILE NAME text box, type the filename. If no file extension is 
specified, an extension will be appended to the specified filename based on 
the selected file type. 

• Choose the OK button. 

 

Printing the Results 
Once a successful run has been performed you may print the displayed diagram 
using File | Print Screen command. if the Solve | Results File option was selected 
you may print the results file using File | Print Results . pcaColumn sends the 
printout to the printer selected in the Print dialog box.  

• Select File | Print Results or File | Print Screen. A dialog box appears. 

• Select the printer to send the results to. 

• Use Print dialog controls to set up the printer options. 

• Choose the OK button to start the printing or choose the CANCEL to 
terminate the print job. 
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General Information 
The General Information command allows you to define or change options that 
will affect the rest of the input.  

• Select Input | General Information. 
A dialog box appears. 

• Enter the PROJECT, COLUMN, and ENGINEER 
labels.  

• Select the units of measure, ENGLISH or 
METRIC.  

• Select the axis about which the column 
capacity is to be computed: ABOUT X-AXIS, 
ABOUT Y-AXIS, or BIAXIAL.  

• Select the design code to conform to: ACI 
318-05, ACI 318-02, CSA A23.3-04 or CSA 
A23.3-04.  

• Choose a run option: INVESTIGATION or 
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DESIGN.  

• Specify whether slenderness effects are to be considered or not by checking 
either YES or NO under the CONSIDER SLENDERNESS? option.  

• Choose the OK button. 

Material Properties 

 
• Select Input | Material Properties. A dialog box appears. 

• Enter the concrete compressive strength, f’c under STRENGTH, f’c. The 
modulus of elasticity, Ec, under ELASTICITY, Ec; the constant stress 
intensity, fc at the maximum usable strain used to calculate the force on 
concrete, under MAX STRESS, fc; the factor used to determine the depth of 
the stress block, under BETA(1); and the maximum usable strain at the 
extreme concrete compression fiber, at the ULTIMATE STRAIN are 
automatically computed and displayed. Modify any of the values if different 
that computed.  

• For the reinforcing steel, enter the yield strength, fy under STRENGTH, fy, 
and the modulus of elasticity, Es under the ELASTICITY, Es. 

• Choose the OK button. 

Section / Rectangular 

Inputting for the Investigation Option: 
• Select Input | Section | Rectangular. A dialog box appears. 
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• Enter the width and depth of the rectangular section 
using WIDTH (ALONG X) and DEPTH (ALONG Y) 
respectively. Note that width is measured along the 
x-axis and depth is measured along the y-axis. 

• Choose the OK button. 

Inputting for the Design Option:  
• Select Input | Section | Rectangular. A dialog box appears. 

• Enter the starting and ending values for 
each dimension (width and depth) along 
with an increment for each dimension 
under START, END and INCREMENT 
columns along WIDTH (ALONG X) and 
DEPTH (ALONG Y). Note that the starting 
and ending values may be the same (in 
which case the increment must be zero).  

• Choose the OK button. 

Section / Circular 

Inputting for the Investigation Option:  
• Select Input | Section | Circular. A dialog box 

appears. 

• Enter the diameter of the column section.  

• Choose the OK button.  

Inputting for the Design Option:  
• Select Input | Section | Circular. A dialog box appears. 

• Enter the starting and ending values the 
diameter along with an increment. Note that 
the starting and ending values may be the 
same (in which case the increment must be 
zero). 

• Choose the OK button. 
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Reinforcement / All Sides Equal 
The Input | Reinforcement | All Sides Equal command allows you to enter the 
total number of bars in the column section. The program attempts to divide the 
bars equally between the four sides of a rectangular layout then equally space them 
on each side. Corner bars are associated with the top and bottom sides, and if the 
total number of bars is not a multiple of four, the top and bottom sides get the extra 
bars. For a circular layout, the program attempts to equally space the bars.  

Inputting for the Investigation Option: 
• Select Input | Reinforcement | All Sides 

Equal. A dialog box appears.  

• Enter the total number of bars in the 
section (must be at least 4 and must be 
a multiple of 4 for a rectangular layout). 
For a circular layout it could be any 
number greater than 4 

• Select the bar size. 

• Enter the clear cover and specify whether 
it is to the transverse (ties) or to the longitudinal bars.  

• Select a bar layout, CIRCULAR or RECTANGULAR. The default is Circular for 
a circular section and Rectangular for a rectangular section.  

• Choose the OK button.  

Inputting for the Design Option 
• Select Input | Reinforcement | All 

Sides Equal. A dialog box appears. 

• Enter the minimum and maximum 
total number of bars in the section 
(must be at least 4 and must be a 
multiple of 4 for a rectangular 
layout).  

• Select the minimum and maximum 
bar sizes along with the clear cover.  
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• Enter the clear cover and specify whether it is to the transverse (ties) or to 
the longitudinal bars.  

• Select a bar layout, Circular or Rectangular. The default is Circular for 
a circular section and Rectangular for a rectangular section.  

Reinforcement / Equal Spacing 
The Input | Reinforcement | Equal Spacing command allows you to enter the 
total number of bars in the column section. The program attempts to place the bars 
equally spaced on all four sides of a rectangular layout. Corner bars are associated 
with the top and bottom sides and if the total number of bars is not a multiple of 4, 
the program does not accept the input.  

Inputting for the Investigation Option:  
• Select Input | Reinforcement | Equal 

Spacing. A dialog box appears. 

• Enter the total number of bars in the 
section NO. OF BARS. (Must be at least 
4 and a multiple of 4).  

• Select the bar size.  

• Enter the clear cover and specify whether it is to the transverse (ties) or to 
the longitudinal bars.  

• Choose the OK button.  

Inputting for the Design Option:  
• Select Input | Reinforcement | 

Equal Spacing. A dialog box 
appears.  

• Enter the minimum and maximum 
total number of bars in the section 
under MINIMUM and MAXIMUM 
corresponding to NO. OF BARS. 
(must be a multiple of 4). 

• Select the minimum and maximum bar sizes.  
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• Enter the clear cover and specify whether it is to the transverse (ties) or to 
the longitudinal bars.  

• Choose the OK button.  

Reinforcement / Sides Different 

Inputting for the Investigation Option:  
• Select Input | Reinforcement | 

Sides Different. A dialog box 
appears.  

• Enter the number of bars to be 
placed on each of the top, bottom 
(on the top and bottom, number of 
bars needs to be at least 2), left and 
right sides (on the left and right, 
the number of bars may be any 
number) of the rectangular section. Note that corner bars are associated 
with the top and bottom sides.  

• Select the bar size and enter the clear cover for each of the top, bottom, left 
and right sides of the section.  

• Specify whether the clear cover entered is to the transverse (ties) or to the 
longitudinal bars.  

• Choose the OK button.  

Inputting for the Design Option: 
• Select Input | Reinforcement | 

Sides Different. A dialog box 
appears.  

• In the Top and Bottom group, enter 
the minimum and maximum total 
number of bars to be placed on the 
top and bottom sides, along with 
the bar size and the clear cover. 
The number of bars must be 
greater than 4 and a multiple of 2. 
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Corner bars are associated with the top and bottom sides. 

• Select the minimum and maximum bar size and enter the clear cover.  

• Repeat the steps above for the Left and Right sides.  

• Specify whether the clear cover entered is to the transverse (ties) or to the 
longitudinal bars.  

• Choose the OK button.  

Reinforcement / Irregular Pattern 
The Input | Reinforcement | Irregular Pattern command allows you to specify 
any number of bars (up to 10,000) to be placed anywhere within the column 
section. Each bar may have any cross-sectional area. This command is available 
with the Investigation option only. 

• Select Input | Reinforcement | Irregular 
Pattern. If the section is irregular, The 
pcaSection window, where the section 
reinforcement may be graphically input, is 
displayed. Otherwise, a dialog box appears. 

• Enter the bar area, along with its x- and y-
coordinates.  

• Choose the INSERT button. The data are 
added to the list box.  

• Repeat the steps above for each entry.  

• To edit an entry, select it from the list box, 
modify its values in the text boxes, and 
choose the MODIFY button. To change the 
area for several bars at once, select those bars from the list box, enter the 
new area in the AREA text box, and choose MODIFY.  

• To delete a bar entry, select it from the list box and choose the DELETE 
button.  

• Choose the OK button.  
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Reinforcement / Confinement 
• Select Input | Reinforcement | Confinement. A dialog box appears.  

• Select the type of bar confinement: TIED 
(default), SPIRAL, or Other. The capacity 
reduction factors change depending on 
the selection.  

• To modify the capacity reduction factors, 
choose OTHER for confinement type.  

For the ACI code:  

Phi(a) is the reduction factor for 
allowable compression,  

Phi(b) is the strength reduction factor for 
tension controlled failure, 

Phi(c) is the reduction factor for 
compression controlled failure. 

For the CSA code: 

Phi(a) is the reduction factor for allowable compression, 

Phi(s) is the material resistance factor for steel, 

Phi(c) is the material resistance factor for concrete. 

• Specify the tie size associated with the particular longitudinal bar sizes. The 
code requirements are used as defaults. 

• Choose the OK button. 

Reinforcement | Design Criteria 
• Select Input | Reinforcement | Design Criteria. A dialog box appears. 

This command is available with the Design option only. 

• Specify whether the column is to be considered STRUCTURAL (default), 
ARCHITECTURAL, or OTHER. Notice that the minimum and maximum 
reinforcement ratios change depending on the selection. 

• Choose whether bar selection is to be based on MINIMUM NUMBER OF BARS 
(default) or on MINIMUM AREA OF STEEL. 
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• To modify the limiting reinforcement ratios, choose OTHER. Enter the 
minimum and maximum reinforcement ratios in the corresponding text 
boxes.  

• Enter the minimum clear bar spacing and the design-to-required ratio.  

• Choose the OK button.  

 

Slenderness / Factors 
• Select Input | Slenderness | Factors. A dialog 

box appears. Note: this command is available for 
slender columns only.  

• The default values, per the design code, for the 
stiffness reduction factor (used to compute the 
moment magnification factors) and the cracked 
section coefficients for beams and columns are 
displayed. To modify these values, select the 
User-defined option and enter your values.  

• Choose the OK button.  
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Slenderness / Design Column 
• Select Input | Slenderness | Design Column. A dialog box appears. The x-

axis or y-axis data groups may be disabled depending on the active run axis. 
Note: this command is available for slender columns only. 

• Enter the clear column height in the corresponding text box. 

• Specify whether the column is braced against sidesway or not by selecting 
or clearing the NON-SWAY option. 

• For an sway column, enter the ratio of the sum of the critical load of all 
story columns to the critical load of the column under consideration, 
(SUM PC)/PC. Also, enter the ratio of the sum of the factored axial load of 
all story columns to the factored axial load of the column under 
consideration, (SUM PU)/PU. 

• In the EFFECTIVE LENGTH FACTORS group, specify whether the k factor(s) 
are to be user-input or computed by the program, by selecting the 
corresponding option. 

• If you chose Input k Factors, enter the effective length factors for nonsway 
and sway conditions, k(b) and k(s), respectively. 

• Repeat the steps above for each active axis. 

• Choose the OK button. 
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Slenderness / Columns Above and Below 
• Select Input | Slenderness | Columns Above/Below. A dialog box appears. 

Note: this command is available for slender columns only for which the 
COMPUTE k FACTORS option is selected in the DESIGN COLUMN dialog box.  

 
• In the COLUMN ABOVE group, specify whether or not a column above the 

design column exists, by selecting or clearing the NO COLUMN SPECIFIED 
OPTION.  

• If a column above exists; enter the center-to-center height, the width (along 
the x-axis), the depth (along the y-axis), the concrete compressive strength, 
and the concrete modulus of elasticity of the column above in the 
corresponding text boxes. For circular sections, enter zero for the DEPTH 
and input the section diameter in the WIDTH box. If zero is entered for both 
Width and Depth, the dimensions of the design column will be 
automatically used. 

• Repeat the same for the column below or, if the column above and the 
column below are the same, choose the COPY TO COLUMN BELOW button. 

• Choose the OK button.  

Slenderness / X-Beams 
• Select Input | Slenderness | X-Beams. A dialog box appears. Beams 

defined using this command span perpendicular to the x-axis. Note: this 
command is available for slender columns only for which the COMPUTE K 
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FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN 
AXIS is BIAXIAL or uniaxial ABOUT X-AXIS. 

• From the BEAM LOCATION group, choose the appropriate option. The data 
group below updates depending on the selection.  

• For the selected beam, specify whether 
or not a beam exists, by selecting or 
clearing the NO BEAM SPECIFIED 
OPTION.  

• If a beam exists; enter the center-to-
center span length, width, depth, 
concrete compressive strength, 
concrete modulus of elasticity, and 
moment of inertia (if different than 
computed) of the beam.  

• Repeat the steps above for the beams 
ABOVE RIGHT, BELOW LEFT, and 
BELOW RIGHT.  

• Choose the OK button.  

Slenderness / Y-Beams 
• Select Input | Slenderness | Y-

Beams. A dialog box appears. Beams 
defined using this command span 
perpendicular to the y-axis. Note: this 
command is available for slender 
columns only for which the COMPUTE 
K FACTORS option is selected in the 
DESIGN COLUMN dialog box and the 
RUN AXIS is BIAXIAL or uniaxial 
ABOUT Y-AXIS.  

• From the BEAM LOCATION group, 
choose the appropriate option. The 
data group below updates depending 
on the selection.  
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• For the selected beam, specify whether or not a beam exists, by selecting or 
clearing the NO BEAM SPECIFIED OPTION.  

• If a beam exists; enter the center-to-center span length, width, depth, 
concrete compressive strength, concrete modulus of elasticity, and moment 
of inertia (if different than computed) of the beam.  

• Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and 
BELOW RIGHT.  

• Choose the OK button.  

Loads / Factored  
Whether designing or investigating a short (non-
slender) column, factored loads consisting of 
applied axial loads and moments about the active 
axis may be input.  

• Select Input | Loads | Factored. A dialog 
box appears.  

• Enter the factored axial load in the LOAD 
text box.  

• Depending on the active axis, enter the 
factored moment about the x-axis – X-
MOMENT, the factored moment about the y-
axis – Y-MOMENT, or both.  

• Choose the INSERT button. The data are 
added to the list box.  

• Repeat the steps above for each factored load entry.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose the OK button. 
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Loads / Service 
When designing or investigating a short or slender column, service level loads 
consisting of dead, live, lateral (wind and earthquake), and snow axial loads and 
moments at both column ends about the active axis may be input. These loads are 
then factored and combined based on the load combinations.  

• Select Input | Loads | Service. A dialog box appears.  

 
 

• For each of the load cases: dead, live, wind, earthquake, and snow, enter the 
axial load and the applicable moment (about x or y) at the column top and 
bottom.  

• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each entry.  
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• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button. 

• Choose the OK button.  

Load / Control Points 
A non-slender column may be investigated without inputting any loads. The 
capacity of the section is computed along with other important information. This 
command is not available for slender columns or under the Design option.  

• Select Input | Loads | Control Points. 

In the output file, key points on the interaction diagram are listed. For each 
point, the axial load and bending moment capacities, along with the 
corresponding neutral axis depth, are listed. 
For a biaxial run, these points are listed for bending about positive and 
negative X and Y axes.  
For a uniaxial runs, the bar-splice regions are indicated on the interaction 
diagram.  

Loads / Axial Loads 
When investigating a short column (uniaxial runs 
only), grouped factored applied axial loads may be 
input. The corresponding moment capacity for 
each load is computed and output. This command 
is not available under the DESIGN option, for 
biaxial runs, or if the column is slender.  

• Select Input | Loads | Axial Loads. A 
dialog box appears.  

• To input a range of axial loads, enter the 
initial, final and increment values in the 
corresponding text boxes. To input a 
discrete (single) axial load, enter its value 
in the INITIAL text box, and enter zero in the 
FINAL and INCREMENT text boxes.  
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• Choose the INSERT button. The data are added to the list box.  

• Repeat the steps above for each axial load entry you may have.  

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose the OK button.  

Loads / Load Combinations 
pcaColumn allows you to specify up to 50 load combinations. The service load 
input under the load cases (dead, live, wind, earthquake, and snow) are combined 
based on these combinations. A minimum of one combination must be input. 

• Select Input | Loads | 
Load Combinations. A 
dialog box appears. For 
a new file, the default 
combinations per the 
selected code are shown 
in the list box.  

• To add a new 
combination, enter the 
load factors or 
multipliers for each load 
case, DEAD, LIVE, 
WIND, Earthquake (EQ), 
and SNOW.  

• Choose the INSERT 
button. The data are 
added to the list box.  

• Repeat the steps above 
for each load 
combination. Up to fifty 
combinations may be 

defined.  



 

4-22  Operating the Program 

• To edit an entry, select it from the list box, modify its values in the text 
boxes, and choose the MODIFY button.  

• To delete an entry, choose it from the list box and choose the DELETE 
button.  

• Choose OK when done.  

Fliping / Rotating the Section 
This command is available for Irregular sections and for sections with Sides 
Different or Irregular reinforcement.  

• Select Input | Flip/Rotate Section. A dialog box appears.  

• Select one of the options: FLIP SECTION ABOUT 
X-AXIS, FLIP SECTION ABOUT Y-AXIS, or 
ROTATE SECTION. The last option is available 
for irregular sections only.  

• If ROTATE SECTION is selected, enter the angle 
of rotation (clockwise is positive).  

• Choose the OK button.  

Executing a Run 

From the program 
• Select Solve | Results File. This is an option that may be turned ON or OFF 

by choosing it again. With this option ON, an output file will be created 
while the program is solving. The output file is a text file that contains an 
echo of the input along with slenderness calculation output, load 
combinations, and the critical points on the interaction diagram.  

• Select Solve | Design Trace (design option only). This is an option that may 
by turned ON or OFF be choosing it again. With this option ON, if 
designing a column section, the program will pause at each cross section 
and reinforcement layout it tries, and display the cross section with its bars 
in the Information bar.  

• Select Solve | Execute. If more data are needed to solve the problem, an 
error box appears and you will be prompted for the required data. If all the 
needed data are input, the solver portion of pcaColumn will start executing. 
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The Solving box appears with a progress indicator. Click Cancel to 
terminate the solution process. After a successful run, the interaction 
diagram or the contour plot is displayed in the Graphics area of the window.  

 

From command prompt 
pcaColumn run can also be executed from the command line prompt. Input data 
file, output data file, and run options can be passed to the program via parameters. 
For instance typing pcaColumn /i:Examples\Example01.col will run 
pcaColumn and solve the column define in input file Example01.col. 

 
Help on how to use command line parameters can be obtained by typing 
pcaColumn /? at the command prompt. 
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Viewing the Results 
Once a successful run has been performed with the Solve | Results File option 
ON, you may view the results file.  

• Select View | Results. pcaColumn executes the pcaView program, an applet 
that enables viewing of text-based files.  

• Use the scroll bars or the cursor keys to navigate through the file.  

• Select Exit to quit pcaView and return to 
pcaColumn. Changing the Startup Defaults 

You can change some default settings that pcaColumn uses 
when it is started or when the File | New command is 
executed.  

• Select Options | Startup Defaults. A dialog 
box appears. 

• Enter the full path of the directory to which 
pcaColumn defaults when opening a data file.  

• Select the system of units, design code, and 
reinforcement to be used as defaults 

whenever a new file is started.  
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• Enter the name of the program to be used by pcaColumn when viewing 
results. By default, pcaColumn uses pcaView.  

• Enter the number of lines per page to be used in formatting the results file.  

• Choose the SAVE button to save these options in the registry.  

Changing the Reinforcement Bar Set 
• Select Options | Reinforcement. A dialog box appears. 

To select a different set:  
• From the BAR SET drop-down list, select the set to be used. 

• Choose the OK button. 

To create or modify a user-defined set 
• From the BAR SET drop-down list, select USER-DEFINED. The ADD, DELETE 

and MODIFY buttons are enabled.  

• To edit an entry, select it from 
the list box, modify its values, 
and choose the MODIFY button.  

• To delete an entry, select it 
from the list box and choose 
the DELETE button.  

• To add an entry, enter the bar 
size, diameter, area and unit 
weight in the corresponding 
text box, and choose the ADD 
button. The data are added to 
the list box.  

• A user-defined set may be 
saved to disk for use in other 
files. To do so, choose the 
SAVE button after inputting the 
bars. The bar set is saved to the 
file specified by the user. To 
retrieve a saved set, choose the 
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READ button. 

• Choose the OK button.  

Superimposing Diagrams 
After executing a run and selecting the File | Save command, the program saves 
the diagram data in a separate file that has the same filename as the input file, with 
an IAD extension. This file may be later read by the program and two diagrams (of 
different files) may be superimposed for the purpose of comparison. Note that the 
RUN AXIS (uniaxial or biaxial) of the two files must be the same  

• Select View | Superimpose. The open dialog box appears.  

• All files with the IAD extension contained in the current drive and directory 
are displayed in the File Name list box. To open a file that exists in another 
drive or directory, select the drive or directory you want from the DRIVES 
drop-down list or the Directories list box respectively.  

• From the FILE NAME list box, select the file to be opened, or simply type its 
name in the text box.  

• Choose the OK button. If the data is successfully read, the diagram from the 
IAD file (shown dotted) is superimposed over the currently displayed 
diagram.  

• To clear any superimposed diagrams, select the View | Redraw command.  

Viewing the Diagram 
For a uniaxial run, the program computes and displays the P-M interaction 
diagram. For a biaxial run, the program computes the three-dimensional failure 
surface (P, Mx, My). The failure surface can be viewed in one of two ways: 

a) P-M interaction diagram (vertical slice at an angle measured from Mx)  
b) Mx-My contour curve (horizontal slice at a constant axial load). 

Whenever the mouse cursor moves over the Graph area, the axial load, moment, 
and eccentricity are displayed in the Status bar. 

Viewing the Interaction Diagram  
• Select View | P-M Diagram - Full. A dialog box appears.  
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• You may also select View | P-M Diagram – M positive or View | P-M 
Diagram – M negative to view the interaction diagram only for positive or 
negative moments. 

• Specify whether you want to enter an 
angle or the values of the moments that 
produce a view angle by selecting either 
the ANGLE or MOMENTS option, 
respectively. 

• If the ANGLE option was selected, select 
an angle from the list, use the scroll bar 
to pick an angle, or simply enter the 
value in the text box.  

• If the MOMENTS option was selected, enter the values of Mx and My which 
define the view angle. The value of that view angle is computed and shown 
in the ANGLE text box.  

• Choose the OK button. 

• You may browse through the angles by using View | Next angle and View | 
Previous angle respectively.  

Viewing the Contour 
• Select View | Mx-My Diagram. A dialog box 

appears. 

• Select an axial load from the list, use the scroll bar to 
pick a load, or simply enter the value in the text box. 

• Choose the OK button. 

• You may browse through the loads by using View | 
Next Load and View | Previous Load respectively. 

 
 





 

Chapter 5  
Examples 

Example 1 – Capacity of a Square Column 
For a column section60 which is 16” x 16” and reinforced with 4-#8 bars, calculate 
the load moment capacities for the following load conditions: 

Case 1: Bar stress near tension face of member equal to zero, (fs = 0).  

Case 2: Bar stress near tension face of member equal to 0.5fy, (fs = 0.5fy)  

Case 3: At limit for compression controlled sections. (εs = 0.002) 

Case 4: At limit for tension controlled sections. (εs = 0.005) 

Given a concrete of 4000 psi and reinforcing steel 
of 60,000 psi. 

1. From the File menu, choose New. Any input 
data is cleared and the default values are 
restored.  

2. From the Input menu, choose General 
Information.  
• Input the PROJECT header.  

• Select ENGLISH UNITS and ACI 318-05 
code.  

• Select ABOUT X-AXIS for run axis, 
INVESTIGATION for RUN OPTION and NO 
for CONSIDER SLENDERNESS?  

• Choose Ok.  

3. From the Input menu, choose Material Properties.  

                                                           
60 Based on Example 6.4, pp 6-34 from Notes on ACI 318-05 Building Requirements for Structural 
Concrete with Design Applications, Ninth Edition, 2005, Portland Cement Association. 
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• Accept the default properties as they match those in the problem 
statement  

• Choose OK. 

 
4. From the Input menu, choose Section | Rectangular.  

• For the section WIDTH (ALONG X), input 16 

• For the section DEPTH (ALONG Y), input 16. 

• Choose OK. 

 
 
 
5. From the Input menu, choose 

Reinforcement | Equal Spacing.  
• Input 4-#8 bars under NO. OF BARS.  

• Input 1.5 in for the CLEAR COVER and 
select TRANSVERSE BARS. under 
COVER TO. 

• Choose OK. 
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6. From the Input menu, choose Loads | Control Points.  
7. From the Solve menu, choose Execute.  

• The P-MX contour is displayed in the Graphics area.  

8. From the View menu, choose Results.  
• Page through the results file.  

• Choose File | Exit to quit the pcaView program and get back to 
pcaColumn.  

9. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose OK. 

10. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose OK. 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   2 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example01.col                   10:55 AM 
 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\StructurePoint\pcaColumn\Examples\Example01.col 
      Project:  pcaColumn Manual Example 1 
      Column:   PCANotes 6.4                 Engineer: SP 
      Code:     ACI 318-05                   Units: English 
 
      Run Option: Investigation              Slenderness: Not considered 
      Run Axis:   X-axis                     Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 4 ksi                          fy   = 60 ksi 
      Ec    = 3605 ksi                       Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.85 
 
   Section: 
   ======== 
      Rectangular: Width = 16 in             Depth = 16 in 
 
      Gross section area, Ag =  256 in^2 
      Ix =  5461.33 in^4                     Iy =  5461.33 in^4 
      Xo =  0 in                             Yo =  0 in 
 
   Reinforcement: 
   ============== 
      Bar Set: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Layout: Rectangular 
      Pattern: All Sides Equal  (Cover to transverse reinforcement) 
      Total steel area: As = 3.16 in^2 at rho = 1.23% 
      4 #8   Cover = 1.5 in 
 
   Axial Load and Corresponding Moment Capacities: 
   =============================================== 
      Load          fPn       fMnx    N.A. depth    eps_t    Phi 
       No.          kip         k-ft          in 
      ---- ------------ ------------ ----------- -------- ------ 
         1        242.4       148.06        8.14  0.00202  0.650 
                             -148.06        8.14  0.00202  0.650 
         2        193.5       170.50        5.31  0.00469  0.874 
                             -170.50        5.31  0.00469  0.874 
         3        200.9       167.95        5.65  0.00424  0.835 
                             -167.95        5.65  0.00424  0.835 
 
      *** End of output ***  
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Example 2 – Investigation of a slender Non-Sway Column  
Determine the adequacy of a 4” x 20” column61 with 3-#11 bars on each 14” side 
in a nonsway frame with a clear height of 22’6”. Use k=1.0. 

The concrete used is 6000 psi and the reinforcing steel is 60,000 psi. 

The factored load values for the column under consideration are as follows: 

P (kip) 115 kips 

Top Muy (kip-ft) 279 ft-kips 

Bottom Muy (kip-ft) -279 ft-kips 

 

From the File menu, choose New. Any input data is 
cleared and the default values are restored.  

1. From the Input menu, choose General 
Information.  
• Input the PROJECT header.  

• Select ENGLISH units and ACI 318-05 
code.  

• Select BIAXIAL for RUN AXIS, 
INVESTIGATION for RUN OPTION and YES 
for CONSIDER SLENDERNESS?.  

• Choose OK.  

                                                           
61 Based on Example 15.8.5 from Reinforced Concrete Design, by Wang, Salmon and Pincheira, 
Seventh Edition, 2007, John Wiley and Sons, Inc. 
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2. From the Input menu, choose Material Properties. 

• Input 4.5 for the CONCRETE STRENGTH. Change the REINFORCING STEEL 
STRENGTH to 50. Other properties are computed and will be accepted.  

• Choose Ok.  

 
From the Input menu, choose Section | Rectangular.  

• Input 20 and 14 for the SECTION WIDTH (ALONG 
X) and DEPTH (ALONG Y).  

• Choose OK. 

 

3. From the Input menu, choose Reinforcement | Sides 
Different.  
• Input 2-#11 bars for TOP and 

BOTTOM and 1-#11 for LEFT 
and RIGHT. Input 1.5 in for the 
cover and select LONGITUDINAL 
BARS.  

• Choose OK.  
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4. From the Input menu, choose 
Slenderness | Design 
Column.  
• Input 22.5 for the 

column CLEAR HEIGHT.  

• Check NON-SWAY frame 
against SWAY CRITERIA 
and select INPUT ‘K’ 
FACTORS.  

• Choose OK. 

 

 

 

 

 
5. From the Input menu, choose Loads | Service.  
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• Under LIVE, input 71.875 for the AXIAL LOAD, 0 for the X-MOMENTS 
@TOP, 0 for the X-MOMENTS @BOT, 174.375 for the Y-MOMENTS 
@TOP and -174.375 for the Y-MOMENTS @BOTTOM, respectively.  

• Choose Insert to add the entry to the list box.  

• Choose Ok.  

6. From the Input menu, choose Loads | 
Load Combinations.  
• If the list displays thirteen 

combinations, choose only the 
second load combination U2 and 
delete all the others by selecting 
them and using DELETE. Choose 
OK. 

7. From the Solve menu, choose Execute.  
• The solver of the program is started 

and, upon completion, displays the 
interaction diagram of the section 
with the load point plotted within 
the diagram.  

8. From the View menu, choose Results.  
• Page through the results file.  

• Choose FILE | EXIT to quit the 
pcaView program and get back to 
pcaColumn.  

9. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose Ok. 

10. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose OK. 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   2 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example02.col                   11:13 AM 
 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\StructurePoint\pcaColumn\Examples\Example02.col 
      Project:  pcaColumn Manual Example 2 
      Column:   Wang15.18.5                  Engineer: SP 
      Code:     ACI 318-05                   Units: English 
 
      Run Option: Investigation              Slenderness: Considered 
      Run Axis:   Biaxial                    Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 4.5 ksi                        fy   = 50 ksi 
      Ec    = 3823.68 ksi                    Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.825 
 
   Section: 
   ======== 
      Rectangular: Width = 20 in             Depth = 14 in 
 
      Gross section area, Ag =  280 in^2 
      Ix =  4573.33 in^4                     Iy =  9333.33 in^4 
      Xo =  0 in                             Yo =  0 in 
 
   Reinforcement: 
   ============== 
      Bar Set: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #11 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Layout: Rectangular 
      Pattern: Sides Different  (Cover to longitudinal reinforcement) 
      Total steel area: As = 9.36 in^2 at rho = 3.34% 
                        Top       Bottom         Left        Right 
                    --------    --------      --------    -------- 
        Bars          2  #11      2  #11        1  #11      1  #11 
        Cover(in)      2.005       2.005         2.005       2.005 
 
   Slenderness: 
   ============ 
      Sway Criteria: 
      -------------- 
      X-axis: Non-sway column. 
      Y-axis: Non-sway column. 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   3 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example02.col                   11:13 AM 
 
                    Height      Width      Depth           I       f'c           Ec 
      Column Axis       ft         in         in         in^4      ksi          ksi 
      ------ ---- -------- ---------- ---------- ------------ -------- ------------ 
      Design  X       22.5         20         14      4573.33      4.5      3823.68 
              Y       22.5         20         14      9333.33      4.5      3823.68 
      Above   X   (no column specified...) 
              Y   (no column specified...) 
      Below   X   (no column specified...) 
              Y   (no column specified...) 
 
      X-Beams       Length      Width      Depth            I      f'c           Ec 
      Location          ft         in         in         in^4      ksi          ksi 
      ----------- -------- ---------- ---------- ------------ -------- ------------ 
      Above Left   (no beam specified...) 
      Above Right  (no beam specified...) 
      Below Left   (no beam specified...) 
      Below Right  (no beam specified...) 
 
      Y-Beams       Length      Width      Depth            I      f'c           Ec 
      Location          ft         in         in         in^4      ksi          ksi 
      ----------- -------- ---------- ---------- ------------ -------- ------------ 
      Above Left   (no beam specified...) 
      Above Right  (no beam specified...) 
      Below Left   (no beam specified...) 
      Below Right  (no beam specified...) 
 
      Effective Length Factors: 
      ------------------------- 
      Axis     Psi(top)     Psi(bot)  k(Non-sway)      k(Sway)        klu/r 
      ---- ------------ ------------ ------------ ------------ ------------ 
         X        0.000        0.000        1.000        (N/A)        66.81 
         Y        0.000        0.000        1.000        (N/A)        46.77 
 
   Moment Magnification Factors: 
   ============================= 
      Member resistance factor, phi(K) = 0.75 
      Cracked-section coefficients: cI(beams) =  0.35; cI(columns) = 0.7 
 
      0.2*Ec*Ig + Es*Ise (X-axis) =  6.83e+006 kip-in^2 
      0.2*Ec*Ig + Es*Ise (Y-axis) =  2.16e+007 kip-in^2 
 
      X-axis  ---------- Non-sway ------------   ----- Sway ------ 
      Ld/Comb    Pc(kip)   Betad     Cm  Delta      Pc(kip)  Delta 
      ------- ----------  ------ ------ ------   ---------- ------ 
        1 U1         924   0.000  1.000  1.199   --- N/A --- 
 
      Y-axis  ---------- Non-sway ------------   ----- Sway ------ 
      Ld/Comb    Pc(kip)   Betad     Cm  Delta      Pc(kip)  Delta 
      ------- ----------  ------ ------ ------   ---------- ------ 
        1 U1        2919   0.000  1.000  1.055   --- N/A --- 
 
   Load Combinations: 
   ================= 
      U1  =  1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake + 0.000*Snow 
 
   Service Loads: 
   ============== 
          Load   Axial Load     Mx @ Top     Mx @ Bot     My @ Top     My @ Bot 
      No. Case          kip         k-ft         k-ft         k-ft         k-ft 
      --- ---- ------------ ------------ ------------ ------------ ------------ 
        1 Dead         0.00         0.00         0.00         0.00         0.00 
          Live        71.88         0.00         0.00       174.38      -174.38 
          Wind         0.00         0.00         0.00         0.00         0.00 
          EQ           0.00         0.00         0.00         0.00         0.00 
          Snow         0.00         0.00         0.00         0.00         0.00 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   4 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example02.col                   11:13 AM 
 
 
 
   Factored Loads and Moments with Corresponding Capacities: 
   ========================================================= 
      NOTE: Each loading combination includes the following cases: 
            First line  - at column top 
            Second line - at column bottom 
           Load          Pu          Mux         Muy       fMnx        fMny   fMn/Mu    Phi 
      No.  Combo         kip        k-ft        k-ft        k-ft        k-ft 
      --- ------ ----------- ----------- ----------- ----------- ----------- -------- ------ 
        1  1 U1       115.00       11.72      294.47       13.39      336.38    1.142  0.900  
        2             115.00       11.72      294.47       13.39      336.38    1.142  0.900  
 
      *** End of output *** 
 



 

 pcaSection Module  5-15 

Example 3 – Design of a Slender Column in a Sway Frame 
Design a square column62 with a clear height of 16 ft. The column is sway and 
subjected to dead, live and wind loads as shown below. 

 Dead Live Wind 

P (kip) 380 140 0 

Top Mx (kip-ft) 32 20 50 

Bottom Mx (kip-ft) 54 36 50 

 

The column is to be checked for the following load 
combinations: 

U1 = 1.2 D + 1.6 L 
U2 = 1.2 D +0.5 L + 1.6 W 

The calculations in the reference are done based on 
the load combination U2. 

In practice, the ratio ΣPc/ Pc would have to be 
calculated before the problem can be attempted, 
using a trial value of ΣPc/Pc. Here, the value of 
ΣPc/Pc used is 28.67 based on the reference value of 
Pc. There are 14 interior columns, 18 exterior 
columns and 4 corner columns. Therefore, the 
value of ΣPu/Pu = 14 + 18 * 2/3 + 4 * 1/3 = 27.33 
irrespective of the load combination being used. 
1. From the File menu, choose New. Any input 

data is cleared and the default values are 
restored.  

2. From the Input menu, choose General Information.  
• Input the PROJECT header.  

• Select English units and ACI 318-02 code.  

                                                           
62 Based on Example 12.5, pp 405, from Structural Concrete: Theory and Design, by M.N.Hassoun and 
A. Al-Manaseer, Third Edition, 2005, John Wiley and Sons, Inc. 
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• Select ABOUT X-AXIS for RUN AXIS, DESIGN for RUN OPTION and YES for 
CONSIDER SLENDERNESS? 

• Choose OK. 

3. From the Input menu, pick Material Properties.  
• Input 5 for the concrete strength. Other properties are computed and will 

be accepted.  

• Choose OK.  

 
4.  From the Input menu, pick 

Section | Rectangular.  
• Input 18 and 18 for the WIDTH 

(ALONG X) and DEPTH (ALONG Y) 
under both START and END options.  

• Choose OK. 

 
 
5.  From the Input menu, choose 

Reinforcement | Equal Spacing. 
• Input 8-#10 bars and 1.5 in for 

the cover and select TRANSVERSE 
BARS.  

• Choose OK. 
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6. From the Input menu, choose Slenderness | Design Column. 

• Input 16 for the column CLEAR HEIGHT.  

• Check NON-SWAY FRAME under SWAY CRITERIA and input 28.67 and 
27.33 for the ΣPc/Pc and ΣPu/Pu, respectively.  

• Select COMPUTE ‘K’ FACTORS. 

• Choose OK. 

 

7. From the Input menu, choose Slenderness | Columns Above/Below. 
• Clear the NO COLUMN SPECIFIED option.  

• Input 11 for the column height (center-to-center) under HEIGHT (C/C) and 
leave the other data as is.  

• Choose COPY TO COLUMN BELOW.  

• Choose Ok. 
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8. From the Input menu, choose Slenderness | X-Beams. 

•  Choose ABOVE LEFT.  

• Clear the NO BEAM SPECIFIED 
option.  

• Input 20 for the span (center-to-
center) under SPAN(C/C).  

• Input 0.00 and 0.00 for the 
WIDTH and DEPTH, respectively.  

• Input 21436.6 for the moment of 
inertia under INERTIA.  

• Leave the other data as it is.  

• Choose ABOVE RIGHT and click on COPY FROM BEAM LEFT.  

• Choose BELOW LEFT and click on COPY FROM BEAM ABOVE.  

• Choose BELOW RIGHT and click on COPY FROM BEAM ABOVE.  

• Choose OK.  

9. From the Input menu, choose Loads | Service. 
• Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS 

and Y-MOMENTS respectively. 
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• Under LIVE, input 140, 20 and -36 for the AXIAL LOAD, X-MOMENTS 
and Y-MOMENTS, respectively.  

• Under WIND, input 0, 50 and -50 for the AXIAL LOAD, X-MOMENTS 
and Y-MOMENTS, respectively.  

• Choose INSERT to add the entry to the list box.  

• Choose OK. 

 
10. From the Input menu, choose Loads | Load Combinations.  

• If the list displays thirteen combinations, leave the second as it is. Delete 
the remaining combinations using DELETE. Add the combination U2 = 
1.2D + 0.5L + 1.6W. Choose OK.  

11. From the Solve menu, choose Execute.  
• The solver of the program is started and, upon completion, displays the 

interaction diagram of the section with the load points plotted within the 
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diagram. Note that point 2 falls 
just outside the interaction 
diagram indicating inadequate 
capacity of this section.  

12. From the View menu, choose 
Results.  
• Page through the results file.  

• Choose Exit to quit the pcaView 
program and get back to 
pcaColumn.  

13. From the File menu, choose Print 
Results.  
• Select the printer to send the 

text results to. 

• Choose Ok. 

14. From the File menu, choose Print 
Screen.  
• Select the printer to send the 

graphical results to. 

• Choose Ok. 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   2 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example03.col                   11:24 AM 
 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\StructurePoint\pcaColumn\Examples\Example03.col 
      Project:  pcaColumn Manual Example 3 
      Column:   Hassoun 12.5                 Engineer: SP 
      Code:     ACI 318-05                   Units: English 
 
      Run Option: Design                     Slenderness: Considered 
      Run Axis:   X-axis                     Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 5 ksi                          fy   = 60 ksi 
      Ec    = 4030.51 ksi                    Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.8 
 
   Section: 
   ======== 
      Rectangular: Width = 18 in             Depth = 18 in 
 
      Gross section area, Ag =  324 in^2 
      Ix =  8748 in^4                        Iy =  8748 in^4 
      Xo =  0 in                             Yo =  0 in 
 
   Reinforcement: 
   ============== 
      Bar Set: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Bar selection: Minimum number of bars 
      Asmin = 0.01 * Ag = 3.24 in^2,  Asmax = 0.08 * Ag = 25.92 in^2 
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Layout: Rectangular 
      Pattern: All Sides Equal  (Cover to transverse reinforcement) 
      Total steel area: As = 5.08 in^2 at rho = 1.57% 
      4 #10   Cover = 1.5 in 
 
   Slenderness: 
   ============ 
      Sway Criteria: 
      -------------- 
      X-axis: Non-sway column. Sum of Pc = 28.67*Pc   Sum of Pu = 27.33*Pu 
 
                    Height      Width      Depth           I       f'c           Ec 
      Column Axis       ft         in         in         in^4      ksi          ksi 
      ------ ---- -------- ---------- ---------- ------------ -------- ------------ 
      Design  X         16         18         18         8748        5      4030.51 
      Above   X         11         18         18         8748        5      4030.51 
      Below   X         11         18         18         8748        5      4030.51 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   3 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example03.col                   11:24 AM 
 
 
 
      X-Beams       Length      Width      Depth            I      f'c           Ec 
      Location          ft         in         in         in^4      ksi          ksi 
      ----------- -------- ---------- ---------- ------------ -------- ------------ 
      Above Left        20          0     0.0001     21436.6        5      4030.51 
      Above Right       20     0.0001     0.0001     21436.6        5      4030.51 
      Below Left        20     0.0001     0.0001     21436.6        5      4030.51 
      Below Right       20     0.0001     0.0001     21436.6        5      4030.51 
 
      Effective Length Factors: 
      ------------------------- 
      Axis     Psi(top)     Psi(bot)  k(Non-sway)      k(Sway)        klu/r 
      ---- ------------ ------------ ------------ ------------ ------------ 
         X        1.252        1.252        0.825        1.407        51.98 
 
   Moment Magnification Factors: 
   ============================= 
      Member resistance factor, phi(K) = 0.75 
      Cracked-section coefficients: cI(beams) =  0.35; cI(columns) = 0.7 
 
      0.2*Ec*Ig + Es*Ise (X-axis) =  1.33e+007 kip-in^2 
 
      X-axis  ---------- Non-sway ------------   ----- Sway ------ 
      Ld/Comb    Pc(kip)   Betad     Cm  Delta      Pc(kip)  Delta 
      ------- ----------  ------ ------ ------   ---------- ------ 
        1 U1        3120   0.671  0.830  1.170         1794  1.930   
          U2        2792   0.867  0.915  1.223         1794  1.594   
 
   Load Combinations: 
   ================= 
      U1  =  1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake + 0.000*Snow 
      U2  =  1.200*Dead + 0.500*Live + 1.600*Wind + 0.000*EarthQuake + 0.500*Snow 
 
   Service Loads: 
   ============== 
          Load   Axial Load     Mx @ Top     Mx @ Bot     My @ Top     My @ Bot 
      No. Case          kip         k-ft         k-ft         k-ft         k-ft 
      --- ---- ------------ ------------ ------------ ------------ ------------ 
        1 Dead       380.00        32.00       -54.00         0.00         0.00 
          Live       140.00        20.00       -36.00         0.00         0.00 
          Wind         0.00        50.00       -50.00         0.00         0.00 
          EQ           0.00         0.00         0.00         0.00         0.00 
          Snow         0.00         0.00         0.00         0.00         0.00 
 
   Factored Loads and Moments with Corresponding Capacities: 
   ========================================================= 
      NOTE: Each loading combination includes the following cases: 
            First line  - at column top 
            Second line - at column bottom 
          Load             Pu          Mux         fMnx   fMn/Mu  N.A. depth    eps_t    Phi 
      No. Combo           kip         k-ft         k-ft                   in 
      --- ------ ------------ ------------ ------------ -------- ----------- -------- ------ 
        1  1 U1        680.00        70.40       202.73    2.880       14.92  0.00011  0.650  
        2              680.00       122.40       202.73    1.656       14.92  0.00011  0.650  
        3  1 U2        526.00       175.94       239.75    1.363       11.97  0.00088  0.650  
        4              526.00       210.34       239.75    1.140       11.97  0.00088  0.650  
 
      *** End of output *** 
 





 

Chapter 6  
pcaSection Module 

pcaSection is an add-on module to the pcaColumn program. It enables the user to 
investigate irregularly shaped reinforced concrete sections subject to 
a combination of loadings. pcaSection considers a polygonal section reinforced 
with bars located at any location. The section may contain one opening. In 
addition, pcaSection allows easy modification of a circular section by converting it 
into an approximate polygon.  

pcaSection is accessed from within pcaColumn. Once pcaColumn is started, you 
can activate pcaSection by selecting the Section | Irregular command from the 
Input menu. This starts pcaSection, minimizes and locks the pcaColumn window 
and maximizes the pcaSection window. The section geometry may then be defined 
by drawing it on the screen or by inputting the coordinates of the polygon nodes. 
Once the section definition is complete, return to pcaColumn by selecting 
Save and Exit from the Main menu.  

Once the irregular section is defined, its reinforcement is input using pcaSection as 
well. This is done by selecting the Reinforcement | Irregular command from the 
Input menu of pcaColumn. The section reinforcement may also be defined 
graphically.  
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Main Menu  

Drawing Area  
Set the limits for the drawing area and control the grid and snap settings.  

Save and Exit  
Accept the input and/or modifications made in pcaSection and return to 
pcaColumn.  

Exit without Saving  
Discard the input and/or modifications made in pcaSection and return to 
pcaColumn.  

Edit Menu  

Section  
Toggles the input/editing session to the section.  

Opening  
Toggles the input/editing session to the section opening.  

Reinforcement  
Toggles the input/editing session to the section reinforcement.  

Add  
Switches to the Add mode to graphically insert section or opening nodes or 
reinforcing bars.  

Delete  
Switches to the Delete mode to graphically delete section or opening nodes or 
reinforcing bars.  

Move  
Switches to the Move mode to graphically move section or opening nodes or 
reinforcing bars.  
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Modify  
Allows manual editing of the section or opening node coordinates or the 
reinforcing bar area and coordinates.  

View Menu  

Zoom  
Magnifies or reduces the graphical image.  

Pan  
Translates or moves the graphical image.  

Redraw  
Redraws the displayed section and resets the Zoom and Pan actions.  

Grid  
Shows or hides the grid.  

Snap  
Toggles the Snap On and Off. With the SNAP ON, the cursor snaps (sticks) to exact 
locations.  

Labels  
Shows or hides the internal numbering of section (or opening) nodes and bars.  

Status bar  
Shows or hides the Status bar.  

Help Menu  

Index  
Lists all the available help topics about the program.  

About  
Displays copyright information and the version number of the program.  
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Defining the Drawing Area  
• Select Main | Drawing Area. A dialog box 

appears. This step is not needed the first time 
pcaSection is started using pcaColumn’s 
Section | Irregular command. The box is 
automatically displayed. 

• Input the limits (MINIMUM and MAXIMUM) of 
the area within which the section is to be 
drawn in both directions.  

• Input the interval (step) for the grid system. 
The grid is used as a guideline when 
drawing.  

• Select or clear the SHOW GRID option to 
show or hide the grid.  

• Input the interval (STEP) for the snap. The 
snap settings may be different than the grid 
settings and may be different in each 
direction (x and y).  

• Select or clear the SNAP ON option to activate or disable the Snap.  

• Choose the OK button.  

Graphical Editing of the Section or Opening  
In pcaSection, the section (or opening) must be a closed polygon. It is defined by 
inputting the nodes at each corner or vertex of the polygon. No two segments 
(sides) may overlap or cross and no two nodes may coincide. An opening must lie 
completely within the section. 

The coordinates that correspond to the cursor location are always displayed in the 
Status bar. To force the cursor to “stick” to exact locations, turn the SNAP option 
on. The program will snap to locations whose coordinates are multiples of the snap 
steps. 

To add section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section 

(or Edit | Opening). 
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• Switch the input mode to ADD by selecting Edit | Add.  

• If you are editing a section (or opening), you must first click on an existing 
node. Once this is done, you can insert subsequent nodes.  

• Adding a node is done by moving the cursor to a desired location within the 
Graphics area and clicking the left-mouse button.  

• After inserting a node, a line extending from the last added node follows the 
cursor. Click at another location to insert subsequent nodes. A line 
connecting the two nodes is drawn.  

• To end the drawing, click the right-mouse button or press the ESC key. The 
first and last nodes are connected to close the section. Also note that while 
in the ADD mode, moving the cursor outside the Graphics area ends the 
drawing. 

To delete section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section 

(or Edit | Opening).  

• Switch the input mode to DELETE by selecting Edit | Delete.  

• Marquee select the node (or nodes) to be deleted. This is done by moving 
the cursor to one location, pressing the left-mouse button and while holding 
the button down, moving to another location. While moving, a dotted 
rectangle (called the marquee) is drawn. Releasing the left-mouse button 
end the marquee. All nodes that are enclosed with the marquee are deleted 
and the section (or opening) is redrawn. To cancel a marquee action while 
holding down the left-mouse button, press the ESC key or click the right-
mouse button. Also, leaving the Graphics area cancels the marquee 
operation.  

To move section or opening nodes:  
• Switch the input session to Section (or Opening) by selecting Edit | Section 

(or Edit | Opening). 

• Switch the input mode to Move by selecting Edit | Move. 

• Place the cursor over the node to be moved then press and hold the left-
mouse button. As long as the button is held down, moving the cursor moves 
the selected node to the cursor location. Once the node is at the new desired 
location, release the mouse button. To cancel a move action while holding 
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down the left-mouse button, press the ESC key or click the right-mouse 
button. Also, leaving the Graphics area cancels the move operation. 

Graphical Editing of the Reinforcement  
In pcaSection, the reinforcing bars may be located anywhere. The only restriction 
imposed in the program is that no two bars may overlap. The coordinates that 
correspond to the cursor location are always displayed in the Status bar. To force 
the cursor to “stick” to exact locations, turn the Snap option on. The program will 
snap to locations whose coordinates are multiples of the snap steps. While in the 
Reinforcement session, you cannot switch to the Section or Opening sessions 
without returning to pcaColumn. Therefore, the Edit | Reinforcement command 
will have a check mark to its left. You use the command to specify the bar size or 
area and the number of bars to be added. 

To add one single bar at a time: 
• Switch the input mode to Add by selecting 

Edit | Add.  

• Select Reinforcement from the Edit menu. 
A dialog box appears. 

• In the Number of bars box, input 1.  

• Choose the Size option and select the size of 
the bar or choose the Area option and input the 
bar area in the edit box.  

• Choose the OK button.  

• In the Graphics area, point to the desired location and click. A bar is 
inserted.  

• Repeat the step above to insert more bars.  

To generate multiple bars:  
• Switch the input mode to Add by selecting Edit | Add. The command must 

have a check mark left of it.  

• Select Reinforcement from the Edit menu. A dialog box appears.  

• Input the number of bars to be generated (should be greater than 1).  
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• Choose the Size option and select the size of the bar or choose the Area 
option and input the bar area in the edit box.  

• Choose the OK button.  

• In the Graphics area, click at a location (let us call it point A), move the 
cursor to another location and click (let us call it Point B). The specified 
number of equally-spaced bars is added, along the line connecting the 
points A and B. For subsequent generations, point B becomes A and you 
only need to click at the second point (B) to generate more bars.  

• To end the multiple bar generation or move to another location (without 
adding bars), click the right-mouse button or press the ESC key. Also note 
that while in the multiple bar generation of the Add mode, moving the 
cursor outside the Graphics area aborts the generation.  

To delete bars:  
• Switch the input mode to DELETE by selecting Edit | Delete.  

• Marquee select the bar(s) to be deleted. This is done by moving the cursor 
to one location, pressing the left-mouse button and while holding the button 
down, moving to another location. While moving, a dotted rectangle (called 
the marquee) is drawn. Releasing the left-mouse button end the marquee. 
All bars that are enclosed with the marquee are deleted. To cancel a 
marquee action while holding down the left-mouse button, press the ESC 
key or click the right-mouse button. Also, leaving the Graphics area cancels 
the marquee operation. 

To move a bar:  
• Switch the input mode to Move by selecting Edit | Move. 

• Place the cursor over the bar to be moved then press and hold the left-
mouse button. As long as the button is held down, moving the cursor moves 
the selected bar with it. Once the bar is at the new desired location, release 
the mouse button. To cancel a move action while holding down the left-
mouse button, press the ESC key or click the right-mouse button. Also, 
leaving the Graphics area cancels the move operation.  
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Manual Editing of the Section or Opening  
• Switch the input session to Section (or 

Opening) by selecting Edit | Section (or 
Edit | Opening).  

• Select Edit | Modify. A dialog box 
appears. If you have already defined a 
section (or opening), the coordinates of its 
nodes are shown in the list. 

• To add a node, enter its x and y 
coordinates and choose the INSERT button. 
The entry is inserted in the list box 
following the selected entry.  

• To edit an entry, select it from the list box, 
modify its values in the text boxes, and 
choose the MODIFY button.  

• To delete an entry, choose it from the list 
box and choose the DELETE button.  

• Choose the OK button.  

Manual Editing of the Reinforcement  
• Select Edit | Modify. A dialog box 

appears.  

• To edit an entry, select it from the list box, 
modify its values in the text boxes, and 
choose the MODIFY button. You can change 
the area of a group of bars by selecting them 
from the list, enter the new area and choose 
MODIFY.  

• To delete an entry, choose it from the list 
box and choose the DELETE button.  

• Choose the OK button.  
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Zooming and Panning the Image  
Zooming is the enlargement or reduction of the graphical image. Panning is the 
translation or movement of the image.  

Zooming:  
• Select View | Zoom.  

• To enlarge the view (zoom-in): using the left-mouse button, click anywhere 
within the Graphics area. Click again for further magnification.  

• To reduce the view (zoom-out): using the right-mouse button, click 
anywhere within the Graphics area. Click again for further reduction.  

• To reset the Zoom and return to the default, select View | Redraw.  

Panning:  
• Select View | Pan. 

• Place the cursor over the Graphics area. Press the left-mouse button and, 
while still holding the button, move the cursor in the direction you wish to 
pan. A line showing the amount and direction of panning is drawn. 

• Release the mouse button. The view is panned and the image is redrawn. 

• To reset the Pan and return to the default, select View | Redraw. 

Keyboard shortcuts:  
The following keyboard assignments are always active: 

Key combination Action 

Ctrl + Page Up Zoom-in 

Ctrl + Page Down Zoom-out 

Ctrl + Cursor key Pan 

Enter Reset zoom/pan (Redraw) 
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Example 4 – Capacity of an Irregular Section  
Compute horizontal moment capacity Mx of the 
unsymmetrical beam cross section63 shown below. 
Use 3-ksi concrete and 60-ksi reinforcing steel. 

 
Note: when instructed to move to a location (15, 25), move the cursor until the 
cells in the Status bar show “x=15” and “y=25”. 

From the File menu, choose New. 
Any input data is cleared and the 
default values are restored.  

1. From the Input menu, choose 
General Information.  
• Select ENGLISH UNITS and 

ACI 318-02 code.  

• Select BIAXIAL for RUN AXIS, 
Investigation for run option 
and NO for CONSIDER 
SLENDERNESS? 

• Choose OK.  

                                                           
63 Based on Example 5.7, pp 199 from Reinforced Concrete: Mechanics and Design, Fourth Edition, 
2005, Pearson Prentice Hall, Pearson Education Inc. 
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2.  From the Input menu, choose Material Properties.  
• Under CONCRETE, input 3 for the STRENGTH. Other properties are 

computed and will be accepted. 

• Choose OK. 

3. From the Input menu, choose Section | Irregular. The pcaSection module is 
loaded, its window occupies the desktop, and the DRAWING AREA box 
appears.  
• Under Limits, input 0 and 20 for the MINIMUM 

X and MINIMUM Y, respectively.  

• Under limits, input 24 and 4 for the MAXIMUM 
X and MAXIMUM Y, respectively.  

• Under GRID, input 4 and 4 for X and Y grid 
STEP, respectively and check the SHOW GRID 
option.  

• Under SNAP, input 4 and 4 for X and Y STEP, 
respectively and check the SNAP ON option.  

• Choose OK. 

4. The default input session is Section and the default 
input mode is Add (the Edit | Section and 
Edit | Add options are checked). 
• In the Graphics area, move the cursor to the location (0, 0) and click the 

left mouse button. A node is inserted. 

• Move to (12, 0) and click the left mouse button. 

• Move to (12, -20) and click the left mouse button. 

• Move to (24, -20) and click the left mouse button. 

• Move to (24, 4) and click the left mouse button. 

• Move to (0, 4) and click the left mouse button. 

• Move to (0, 0) and click the left mouse button. 

• Click the right-mouse button to end drawing the section. 

5. From the Main menu, choose Save and Exit. You are returned to pcaColumn 
and the section is shown in the Information bar.  
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6. From the Input menu, choose Reinforcement | Irregular. The pcaSection 
module is loaded, its window occupies the desktop. 

7. The default input session is Reinforcement and the default input mode is Add 
(the Edit | Reinforcement and Edit | Add options are checked).  

8. Define some bars using multiple bar generation: 
• From the Edit menu, choose Reinforcement. Input 1 for the NUMBER OF 

BARS and select #9 for the BAR SIZE. Choose 
OK.  

•  Move the cursor to any location and click the 
left mouse button.  

• From the Edit menu, choose Modify. Input 
14.142 for X-COORD and -17.5 for Y-COORD. 
Click MODIFY and then OK. 

• From the Edit menu, choose Reinforcement. 
Input 1 for the NUMBER OF BARS and select #8 from BAR SIZE. Choose 
OK.  

• Move the cursor to any location and click the left mouse button. A #8 bar 
is generated at that location.  

• From the Edit menu choose Modify. Input 
18 for X-COORD and -17.5 for Y-COORD. 
Click MODIFY and then OK. 

• From the Edit menu, choose 
Reinforcement. Input 1 for the NUMBER OF 
BARS and select #8 from BAR SIZE. Choose 
OK. 

• Move the cursor to any location and click 
the left mouse button. A #8 bar is generated 
at that location.  

• From the Edit menu choose Modify. Input 
22 for X-COORD and -17.5 for Y-COORD. 
Click Modify and then Ok  
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9.  From the Main menu, choose Save and Exit. You are returned to pcaColumn 

and the section is shown in the Information 
bar.  

10. From the Input menu, choose Input | 
Loads | .Factored 

11. Enter LOAD as 0 (zero), X-MOMENT as -225 
ft-kips and Y-MOMENT as 0.  

12. From the Solve menu, choose Execute.  
• A message is displayed saying 

“Reinforcement ratio is less than 1% 
Consider column as architectural (i.e. fc 
is reduced by reinforcement ratio?)”. 
Click NO for this option. 

• The solver of the program is started and, 
upon completion, displays the interaction 
diagram of the section.  

13. From the View menu, choose Results.  
• Page through the results file. 

• Choose Exit to quit the pcaView program and get back to pcaColumn. 
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14. From the File menu, choose Print Results.  
• Select the printer to send the text results to. 

• Choose OK. 

15. From the File menu, choose Print Screen.  
• Select the printer to send the graphical results to. 

• Choose OK 

• Change the interaction diagram to show the P-M diagram at 180o using 

the  icon. 
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 STRUCTUREPOINT - pcaColumn v4.10 (TM)                                              Page   2 
 Licensed to: Portland Cement Association. License ID: 00000-0000000-4-2D2DE-21808  05/07/08 
 C:\Program Files\StructurePoint\pcaColumn\Examples\Example04.col                   11:35 AM 
 
 
   General Information: 
   ==================== 
      File Name: C:\Program Files\StructurePoint\pcaColumn\Examples\Example04.col 
      Project:  pcaColumn Manual Example 4 
      Column:   MacGregor5.7                 Engineer: SP 
      Code:     ACI 318-05                   Units: English 
 
      Run Option: Investigation              Slenderness: Not considered 
      Run Axis:   Biaxial                    Column Type: Structural 
 
   Material Properties: 
   ==================== 
      f'c   = 3 ksi                          fy   = 60 ksi 
      Ec    = 3122.02 ksi                    Es   = 29000 ksi 
      Ultimate strain = 0.003 in/in 
      Beta1 = 0.85 
 
   Section: 
   ======== 
      Exterior Points 
        No.     X (in)     Y (in)    No.     X (in)     Y (in)    No.     X (in)     Y (in) 
      ----- ---------- ----------  ----- ---------- ----------  ----- ---------- ---------- 
          1        0.0        0.0      2       12.0        0.0      3       12.0      -20.0 
          4       24.0      -20.0      5       24.0        4.0      6        0.0        4.0 
 
      Gross section area, Ag =  336 in^2 
      Ix =  18002.3 in^4                     Iy =  9956.56 in^4 
      Xo =  16.2857 in                       Yo =  -6.57143 in 
 
   Reinforcement: 
   ============== 
      Bar Set: ASTM A615 
      Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2)   Size Diam (in) Area (in^2) 
      ---- --------- -----------   ---- --------- -----------   ---- --------- ----------- 
      #  3      0.38        0.11   #  4      0.50        0.20   #  5      0.63        0.31 
      #  6      0.75        0.44   #  7      0.88        0.60   #  8      1.00        0.79 
      #  9      1.13        1.00   # 10      1.27        1.27   # 11      1.41        1.56 
      # 14      1.69        2.25   # 18      2.26        4.00  
 
      Confinement: Tied; #3 ties with #10 bars,  #4 with larger bars. 
      phi(a) = 0.8,  phi(b) = 0.9,  phi(c) = 0.65 
 
      Pattern: Irregular    
 
      Total steel area, As = 2.58 in^2 at 0.77% (Note: rho < 1.0%) 
 
      Area in^2   X (in)   Y (in)  Area in^2   X (in)   Y (in)  Area in^2   X (in)   Y (in) 
      --------- -------- --------  --------- -------- --------  --------- -------- -------- 
           1.00     14.1    -17.5       0.79     18.0    -17.5       0.79     22.0    -17.5  
 
   Factored Loads and Moments with Corresponding Capacities: 
   ========================================================= 
                  Pu          Mux         Muy       fMnx         fMny   fMn/Mu    Phi 
      No.         kip        k-ft        k-ft        k-ft        k-ft 
      --- ----------- ----------- ----------- ----------- ----------- -------- ------ 
        1        0.00     -225.00        0.00     -224.43       -0.00    0.997  0.900# 
 
      # Section capacity exceeded! 
 
      *** End of output *** 

 





 

 Appendix 
Import File Formats 

Geometry, reinforcement or load data may be imported from a text file. The import 
file must be saved in pure ASCII (text) format. Data fields on each line should be 
separated by spaces or TABs. Comments or blank lines should not be placed 
within the import file. 

Service Loads Data: 
No_Of_Load_Points 
P1_D M1x_DT M1x_DB M1y_DB M1y_DB 
P1_L M1x_LT M1x_LB M1y_LT M1y_LB 
P1_W M1x_WT M1x_WB M1y_WT M1y_WB 
P1_EQ M1x_EQT M1x_EQB M1y_EQT M1y_EQB 
P1_S M1x_ST M1x_SB M1y_ST M1y_SB 
 
. 
. 
Pn_D Mnx_DT Mnx_DB Mny_DB Mny_DB 
Pn_L Mnx_LT Mnx_LB Mny_LT Mny_LB 
Pn_W Mnx_WT Mnx_WB Mny_WT Mny_WB 
Pn_EQ Mnx_EQT Mnx_EQB Mny_EQT Mny_EQB 
Pn_S Mnx_ST Mnx_SB Mny_ST Mny_SB 
 
Each service load point has five lines of data (one line for each load case, i.e. 
Dead, Live, Wind, Earthquake, and Snow). Each data line has five values. For a 
service load point i, Pi_D, Mix_DT, Mix_DB, Miy_DT, and Miy_DB are the 
axial load, Mx at top, Mx at bottom, My at top and My at bottom, respectively. The 
notation D, L, W, EQ, and S designate the Dead, Live, Wind, Earthquake, and 
Snow load cases, respectively. 

Factored Loads Data: 
No_Of_Load_Points 
P1 M1x M1y 
P2 M2x M2y 
. 
. 
Pn Mnx Mny 
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For a factored load point i, Pi is the factored axial load, Mix is the factored 
moment about x and Miy is the factored moment about y. 

Reinforcement Data: 
No_Of_Bars 
A1 X1 Y1 
. 
. 
An Xn Yn 
 
For a bar i, Ai is the bar area, Xi is its x-coordinate, and Yi is its y-coordinate. 

Geometry Data: 
No_Of_Section_Nodes 
Xs1 Ys1 
Xs2 Ys2 
. 
. 
. 
Xsn Ysn 
No_Of_Opening_Nodes 
Xo1 Yo1 
Xo2 Yo2 
. 
. 
. 
Xon Yon 
 
For a section node si, Xsi is the x-coordinate of the node and Ysi is its y-
coordinate. 
For an opening node oi, Xoi is the x-coordinate of the node and Yoi is its y-
coordinate. 
If the section does not contain an opening, you must have a zero for the value of 
No_Of_Opening_Nodes. 
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pcaColumn Text Input (CTI) file format 
pcaColumn is able to read and save input data file into two formats, COL file or 
CTI file. CTI files are plain text files that can be edited by any text editing 
software. 
 
Caution must be used when editing a CTI file because some values may be 
interrelated. If one of these values is changed, then other interrelated values should 
be changed accordingly. While this is done automatically when a model is edited 
in the pcaColumn user graphic user interface (GUI), one must update all the 
related values in a CTI file manually in order to obtain correct results. For 
example, if units are changed from English to Metric in GUI, all the related input 
values are updated automatically. If this is done by editing a CTI file, however, not 
only the unit flag but also all the related input values must be updated manually. 
 
The best way to create a CTI file is by using the pcaColumn GUI and selecting 
CTI file type in the Save As menu command. Then, any necessary modifications to 
the CTI file can be applied with any text editor. However, it is recommended that 
users always verify modified CTI files by loading them in the pcaColumn GUI to 
ensure that the modifications are correct before running manually revised CTI files 
in batch mode. 
 
A CTI file is organized by sections. Each section contains a title in square 
brackets, followed by values required by the section. A CTI file contains the 
following sections. 
 
[pcaColumn Version] 
[Project] 
[Column ID] 
[Engineer] 
[Investigation Run Flag] 
[Design Run Flag] 
[Slenderness Flag] 
[User Options] 
[Irregular Options] 
[Ties] 
[Investigation Reinforcement] 
[Design Reinforcement] 
[Investigation Section Dimensions] 
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[Design Section Dimensions] 
[Material Properties] 
[Reduction Factors] 
[Design Criteria] 
[External Points] 
[Internal Points] 
[Reinforcement Bars] 
[Factored Loads] 
[Slenderness: Column] 
[Slenderness: Column Above And Below] 
[Slenderness: Beams] 
[EI] 
[SldOptFact] 
[Phi_Delta] 
[Cracked I] 
[Service Loads] 
[Load Combinations] 
[BarGroupType] 
[User Defined Bars] 
 
Each section of a CTI file and allowable values of each parameter are described in 
details below. Corresponding GUI commands are presented in parenthesis. 
 
#pcaColumn Text Input (CTI) File 
A number sign, #, at the beginning of a line of text indicates that the line of text is 
comment. The # sign must be located at the beginning of a line. Comments may be 
added anywhere necessary in a CTI file to make the file more readable. If a 
comment appears in multiple lines, each line must be started with a # sign. 
 
[pcaColumn Version] 
Reserved. Do not edit. 
 
[Project] 
There is one line of text in this section.  
 
Project name (menu Input | General Information…) 
 
[Column ID] 
There is one line of text in this section.  
 
Column ID (menu Input | General Information…) 
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[Engineer] 
There is one line of text in this section.  
 
Engineer name (Menu Input | General Information…) 
 
[Investigation Run Flag] 
Reserved. Do not edit. 
 
[Design Run Flag] 
Reserved. Do not edit. 
 
[Slenderness Flag] 
Reserved. Do not edit. 
 
[User Options] 
There are 26 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. 
 

1. 0-Investigation Mode; 1-Design Mode; (Run Option on menu Input | 
General Information…) 

2. 0-English Unit; 1-Metric Units; (Units on menu Input | General 
Information…) 

3. 0-ACI 318-02; 1- CSA A23.3-94; 2-ACI 318-05; 3-CSA A23.3-04; (Design 
Code on menu Input | General Information…) 

4. 0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | 
General Information…) 

5. Reserved. Do not edit. 
6. 0-Slenderness is not considered; 1-Slenderness in considered; (Consider 

slenderness? on menu Input | General Information…) 
7. 0-Design for minimum number of bars; 1-Design for minimum area of 

reinforcement; (Bar selection on menu Input | Reinforcement | Design 
Criteria…) 

8. Reserved. Do not edit. 
9. 0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular 

Column Section; (menu Input | Section) 
10. 0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar 

Layout on menu Input | Reinforcement | All Sides Equal) 
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11. 0-Structural Column Section; 1-Architectural Column Section; 2-User 
Defined Column Section; (Column Type on menu Input | Reinforcement | 
Design Criteria…) 

12. 0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; 
(Confinement drop-down list on menu Input | Reinforcement | 
Confinement…) 

13. Load type for investigation mode: (menu Input | Loads) 
0-Factored; 1-Service; 2-Control Points; 3-Axial Loads 

14. Load type for design mode: (menu Input | Loads) 
0-Factored; 1-Service; 2-Control Points; 3-Axial Loads 

15. Reinforcement layout for investigation mode: (menu Input | Reinforcement) 
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern 

16. Reinforcement layout for design mode: (menu Input | Reinforcement) 
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern 

17. Reserved. Do not edit. 
18. Number of factored loads (menu Input | Loads | Factored…) 
19. Number of service loads (menu Input | Loads | Service…) 
20. Number of points on exterior column section  
21. Number of points on interior section opening 
22. Reserved. Do not edit. 
23. Reserved. Do not edit. 
24. Cover type for investigation mode: (menu Input | Reinforcement) 

0-To transverse bar; 1-To longitudinal bar 
25. Cover type for design mode: (menu Input | Reinforcement) 

0-To transverse bar; 1-To longitudinal bar 
26. Number of load combinations; (menu Input | Load | Load Combinations…) 

 
[Irregular Options] 
There are 13 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. (menu Input | 
Section | Irregular | Section Editor menu Main | Drawing Area) 
 

1. Reserved. Do not edit. 
2. Reserved. Do not edit. 
3. Reserved. Do not edit. 
4. Reserved. Do not edit. 
5. Area of reinforcing bar that is to be added through irregular section editor 
6. Maximum X value of drawing area of irregular section editor 
7. Maximum Y value of drawing area of irregular section editor 
8. Minimum X value of drawing area of irregular section editor 
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9. Minimum Y value of drawing area of irregular section editor 
10. Grid step in X of irregular section editor 
11. Grid step in Y of irregular section editor 
12. Grid snap step in X of irregular section editor 
13. Grid snap step in Y of irregular section editor 

 
[Ties] 
There are 3 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. (Menu Input | 
Reinforcement | Confinement…) 
 

1. Index (0 based) of tie bars for longitudinal bars smaller that the one 
specified in the 3rd item in this section in the drop-down list 

2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified 
in the 3rd item in this section in the drop-down list 

3. Index (0 based) of longitudinal bar in the drop-down list 
 
[Investigation Reinforcement] 
This section applies to investigation mode only. There are 12 values separated by 
commas in one line in this section. These values are described below in the order 
they appear from left to right. 
 
If Side Different (Menu Input | Reinforcement | Side Different…) is selected: 
 

1. Number of top bars 
2. Number of bottom bars 
3. Number of left bars 
4. Number of right bars 
5. Index (0 based) of top bars (Top Bar Size drop-download list) 
6. Index (0 based) of bottom bars (Bottom Bar Size drop-download list) 
7. Index (0 based) of left bars (Left Bar Size drop-download list) 
8. Index (0 based) of right bars (Right Bar Size drop-download list) 
9. Clear cover to top bars 
10. Clear cover to bottom bars 
11. Clear cover to left bars 
12. Clear cover to right bars 

 
If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal 
Spacing (Menu Input | Reinforcement | Equal Spacing…) is selected: 
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1. Number of bars (No. of Bars text box) 
2. Reserved. Do not edit. 
3. Reserved. Do not edit. 
4. Reserved. Do not edit. 
5. Index (0 based) of bar (Bar Size drop-down list) 
6. Reserved. Do not edit. 
7. Reserved. Do not edit. 
8. Reserved. Do not edit. 
9. Clear cover to bar (Clear Cover text box) 
10. Reserved. Do not edit. 
11. Reserved. Do not edit. 
12. Reserved. Do not edit. 

 
If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern…) is selected: 
 
Reserved. Do not edit. 
 
[Design Reinforcement] 
This section applies to design mode only. There are 12 values separated by 
commas in one line in this section. These values are described below in the order 
they appear from left to right. 
 
If Side Different (Menu Input | Reinforcement | Side Different…) is selected: 
 

1. Minimum number of top and bottom bars 
2. Maximum number of top and bottom bars 
3. Minimum number of left and right bars 
4. Maximum number of left and right bars 
5. Index (0 based) of minimum size for top and bottom bars 
6. Index (0 based) of maximum size for top and bottom bars 
7. Index (0 based) of minimum size for left and right bars 
8. Index (0 based) of maximum size for left and right bars 
9. Clear cover to top and bottom bars 
10. Reserved. Do not edit. 
11. Clear cover to left and right bars 
12. Reserved. Do not edit. 

 
If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal 
Spacing (Menu Input | Reinforcement | Equal Spacing…) is selected: 
 



 

Appendix  A-9 

1. Minimum number of bars 
2. maximum number of bars 
3. Reserved. Do not edit. 
4. Reserved. Do not edit. 
5. Index (0 based) of minimum size of bars 
6. Index (0 based) of maximum size of bars 
7. Reserved. Do not edit. 
8. Reserved. Do not edit. 
9. Clear cover 
10. Reserved. Do not edit. 
11. Reserved. Do not edit. 
12. Reserved. Do not edit. 

 
[Investigation Section Dimensions] 
This section applies to investigation mode only. There are 2 values separated by 
commas in one line in this section. These values are described below in the order 
they appear from left to right. 
 
If rectangular section (Menu Input | Section | Rectangular…) is selected: 
 

1. Section width (along X) 
2. Section depth (along Y) 

 
If circular section (Menu Input | Section | Circular…) is selected: 
 

1. Section diameter 
2. Reserved. Do not edit. 

 
If irregular section (Menu Input | Section | Irregular) is selected: 
 

1. Reserved. Do not edit. 
2. Reserved. Do not edit. 

 
[Design Section Dimensions] 
This section applies to design mode only. There are 6 values separated by commas 
in one line in this section. These values are described below in the order they 
appear from left to right. 
 
If rectangular section (Menu Input | Section | Rectangular…) is selected: 
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1. Section width (along X) Start 
2. Section depth (along Y) Start 
3. Section width (along X) End 
4. Section depth (along Y) End 
5. Section width (along X) Increment 
6. Section depth (along Y) Increment 

 
If circular section (Menu Input | Section | Circular…) is selected: 
 

1. Diameter start 
2. Reserved. Do not change. 
3. Diameter end 
4. Reserved. Do not change. 
5. Diameter increment 
6. Reserved. Do not change. 

 
[Material Properties] 
There are 8 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. (Menu Input | 
Material Properties…) 
 

1. Concrete strength, f’c 
2. Concrete modulus of elasticity, Ec 
3. Concrete maximum stress, fc 
4. Beta(1) for concrete stress block 
5. Concrete ultimate strain 
6. Steel yield strength, fy 
7. Steel modulus of elasticity, Es 
8. Reserved. Do not edit. 

 
[Reduction Factors] 
There are 4 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. (Menu Input | 
Reinforcement | Confinement…) 
 

1. Phi(a) for axial compression 
2. Phi(b) for tension-controlled failure 
3. Phi(c) for compression-controlled failure 
4. Reserved. Do not edit. 
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[Design Criteria] 
There are 4 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. (Menu Input | 
Reinforcement | Design Criteria…) 
 

1. Minimum reinforcement ratio 
2. Maximum reinforcement ratio 
3. Minimum clear spacing between bars 
4. Design/Required ratio 

 
[External Points] 
This section applies to irregular section in investigation mode only. The first line 
contains the number of points on exterior section perimeter. Each of the following 
lines contains 2 values of X and Y coordinates (separated by comma) of a point. 
 
Number of Points, n 
Point_1_X, Point_1_Y 
Point_2_X, Point_2_Y 
. 
. 
. 
Point_n_X, Point_n_Y 
 
[Internal Points] 
This section applies to irregular section in investigation mode only. The first line 
contains the number of points on an interior opening perimeter. Each of the 
following lines contains 2 values of X and Y coordinates (separated by comma) of 
a point. If no opening exists, then the first line must be 0. 
 
Number of Points, n 
Point_1_X, Point_1_Y 
Point_2_X, Point_2_Y 
. 
. 
. 
Point_n_X, Point_n_Y 
 
[Reinforcement Bars] 
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This section applies to irregular section in investigation mode only. The first line 
contains the number of reinforcing bars. Each of the following lines contains 3 
values of area, X and Y coordinates (separated by comma) of a bar.  
 
Number of bars, n 
Bar_1_area, Bar_1_X, Bar_1_Y 
Bar_2_area, Bar_2_X, Bar_2_Y 
. 
. 
. 
Bar_n_area, Bar_n_X, Bar_n_Y 
 
[Factored Loads] 
The first line contains the number of factored loads defined. Each of the following 
lines contains 3 values of axial load, X-moment, and Y-moment separated by 
commas. (Menu Input | Loads | Factored Loads…) 
 
Number of Factored Loads, n 
Load_1, X-Moment_1, Y-Moment_1 
Load_2, X-Moment_2, Y-Moment_2 
. 
. 
. 
Load_n, X-Moment_n, Y-Moment_n 
 
[Slenderness: Column] 
This section contains 2 lines describing slenderness parameters for column being 
designed. The first line is for X-axis parameters, and the second line is for Y-axis 
parameters. 
 
There are 5 values separated by commas in each line. These values are described 
below in the order they appear from left to right. (Menu Input | Slenderness | 
Design Column…) 
 

1. Column clear height 
2. k(braced) 
3. k(sway) 
4. 0-Non-sway frame; 1-Sway frame 
5. 0-Compute ‘k’ factors; 1-Input k factors 
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[Slenderness: Column Above And Below] 
This section contains 2 lines describing slenderness parameters for column above 
and column below. The first line is for column above, and the second line is for 
column below. (Menu Input | Slenderness | Columns Above/Below…) 
 
There are 6 values separated by commas in line 1 for column above. These values 
are described below in the order they appear from left to right.  
 

1. 0-Column specified; 1-No column specified 
2. Column Height 
3. Column width (along X) 
4. Column depth (along Y) 
5. Concrete compressive strength, f’c 
6. Concrete modulus of elasticity, Ec 

 
There are 6 values separated by commas in line 2 for column below. These values 
are described below in the order they appear from left to right. 
 

1. 0-Column specified; 1-No column specified 
2. Column Height 
3. Column width (along X) 
4. Column depth (along Y) 
5. Concrete compressive strength, f’c 
6. Concrete modulus of elasticity, Ec 

 
[Slenderness: Beams] 
This section contains 8 lines. Each line describes a beam.  
 
Line 1: X-Beam (perpendicular to X), Above Left 
Line 2: X-Beam (perpendicular to X), Above Right 
Line 3: X-Beam (perpendicular to X), Below Left 
Line 4: X-Beam (perpendicular to X), Below Right 
Line 5: Y-Beam (perpendicular to Y), Above Left 
Line 6: Y-Beam (perpendicular to Y), Above Right 
Line 7: Y-Beam (perpendicular to Y), Below Left 
Line 8: Y-Beam (perpendicular to Y), Below Right 
 
There are 7 values separated by commas for each beam in each line. (Menu Input | 
Slenderness | X-Beams…, Input | Slenderness | Y-Beams…) These values are 
described below in the order they appear from left to right. 
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1. 0-beam specified; 1-no beam specified 
2. Beam span length (c/c) 
3. Beam width 
4. Beam depth 
5. Beam section moment of inertia 
6. Concrete compressive strength, f’c 
7. Concrete modulus of elasticity, Ec 

 
[EI] 
Reserved. Do not edit. 
 
[SldOptFact] 
There is 1 value in this section for slenderness factors. (Code Default and User 
Defined radio buttons on menu Input | Slenderness | factors…) 
 
0-Code default; 1-User defined 
 
[Phi_Delta] 
There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | 
factors…) 
 
Stiffness reduction factor 
 
[Cracked I] 
There are 2 values separated by commas in one line in this section. These values 
are described below in the order they appear from left to right. (Menu Input | 
Slenderness | factors…) 
 

1. Beam cracked section coefficient 
2. Column cracked section coefficient 

 
[Service Loads] 
This section describes defined service loads. (Menu Input | Loads | Service…) The 
first line contains the number of service loads. Each of the following lines contains 
values for one service load. 
 
There are 25 values for each service load in one Line separated by commas. These 
values are described below in the order they appear from left to right. 
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1. Dead Axial Load 
2. Dead X-moment at top 
3. Dead X-moment at bottom 
4. Dead Y-moment at top 
5. Dead Y-moment at bottom 
6. Live Axial Load 
7. Live X-moment at top 
8. Live X-moment at bottom 
9. Live Y-moment at top 
10. Live Y-moment at bottom 
11. Wind Axial Load 
12. Wind X-moment at top 
13. Wind X-moment at bottom 
14. Wind Y-moment at top 
15. Wind Y-moment at bottom 
16. EQ. Axial Load 
17. EQ. X-moment at top 
18. EQ. X-moment at bottom 
19. EQ. Y-moment at top 
20. EQ. Y-moment at bottom 
21. Snow Axial Load 
22. Snow X-moment at top 
23. Snow X-moment at bottom 
24. Snow Y-moment at top 
25. Snow Y-moment at bottom 

 
[Load Combinations] 
This section describes defined load combinations. (Menu Input | Loads | Load 
Combinations…) The first line contains the number of load combinations. Each of 
the following lines contains load factors for one load combination. 
 
Number of load combinations, n 
Dead_1, Live_1, Wind_1, E.Q._1, Snow_1 
Dead_2, Live_2, Wind_2, E.Q._2, Snow_2 
. 
. 
. 
Dead_n, Live_n, Wind_n, E.Q._n, Snow_n 
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[BarGroupType] 
There is 1 value in this section. (Bar Set drop-down list on menu Options | 
Reinforcement…) 
 
0-User defined 
1-ASTM615 
2-CSA G30.18 
3-prEN 10080 
4-ASTM615M 
 
[User Defined Bars] 
This section contains user-defined reinforcing bars. (Menu Options | 
Reinforcement…) The first line contains the number of defined bars. Each of the 
following lines contains values for one bar separated by commas. 
 
Number of user-defined bars, n 
Bar_1_size, Bar_1_diameter, Bar_1_area, Bar_1_weight 
Bar_2_size, Bar_2_diameter, Bar_2_area, Bar_2_weight 
. 
. 
. 
Bar_n_size, Bar_n_diameter, Bar_n_area, Bar_n_weight 
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Conversion Factors - English to SI 

To convert from  To  Multiply by 
in. m (1000 mm)  0.025400 
ft m  0.304800 
lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 
plf (lb/ft)  N/m  14.593904 

psi (lb/in.2)  kPa  6.894757 
ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2 (Pa)  47.88026 
pcf (lb/ft3)  kg/m3  16.018460 

ft-kips  kN • m  1.355818 
 

Conversion Factors - SI to English. 
 

To convert from To  Multiply by  
m (1000 mm) in  39.37008  

m ft  3.28084  
N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  
kN/m plf (lb/ft)  68.52601  
MPa psi (lb/in2)  145.0377  
MPa ksi (kips/in2)  0.145038  

kN/m2 (kPa) psf (lb/ft2)  20.88555  
kg/m3  pcf (lb/ft3)  0.062428  
kN • m  ft-kips  0.737562  
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Contact Information 
 

Web Site:  http://www.StructurePoint.org 

E-mail:  info@StructurePoint.org  
 support@StructurePoint.org  

 StructurePoint, LLC.  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-4357  
Fax:  (847) 966-1542  
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